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1 Quick Overview

Text Section + Exercises Section

Contain numerous Metal Engineering exercises.

Glossary

Describes and explains the basic CAD terms.

Index

Contains an alphabetical list of the training book contents, with references to the corresponding

pages.

Notes

Empty space where you can make your own notes on the Metal Engineering Training.

9 Darstellungsmaglichkeiten

8.1.1 Tangentiale Kanten / Linien
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2 Training Content and Requirements

v, The “HICAD Metal (Glass/Facade) Engineering, Advanced® training is a follow-up training,
building on the knowledge conveyed in the “HICAD Metal (Glass/Facade) Engineering, Basic*
training. It addresses users who already have a good knowledge of the HICAD modules 2-D, 3-
D, Sheet Metal and Steel Engineering, which is required for this training.

wvd

Besides explaining the special functions for 2-D and 3-D glazing constructions, this training is
meant to convey the optimal designing methods for the complete construction of complex
Metal Engineering objects in 3-D, and the connection of elements required in drawings
and the actual construction.

The training will convey

B practice-oriented, efficient methods for the designing of Metal Engineering objects,

B methods for the designing of wall connections in 3-D,

B methods for the designing of Sheet Metal parts in 3-D for wall connections and transitions,
B methods for the designing of geometries in 3-D that are already exist on-site.

Besides the designing in 3-D, the fraining also explains the creation of
customer/architect/production documents. These include:

the deriving of sectional views,

the creation of overviews and details,

the generation of dimensioned profile production drawings,
glass pane drawings for orders,

sheet developments, or

Bills of Materials (BOMs)

on the basis of the data of the 3-D drawing.

If desired, advanced functionalities, e.g. for
B the definition of multi-part standard beams and profiles, or

B the creation of user-defined catalogues for frequently required purchased parts and
recurring assemblies

can also be explained in the training.

To enable a simplified insertion of beam and profile cross-sections from different facade system
suppliers, the interface with the software program LogiKal by the company ORGADATA will be
used in the training. Users who do not have this software and/or the corresponding HiCAD
interface, or customers using self-defined beam and profile systems will be shown how to define
their own beam and profile cross-sections.

6 2-D/3-D Metal Engineering
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3 FAQ

Experience has shown that some questions arise particularly frequently. To spare you
unnecessary browsing through the pages we will begin with 13 FAQs:

Question 1: What are the functions of the mouse buttons?
a) Left mouse button (LMB): Select function / confirm entry (e.g. a radius)

b) Middle mouse button (MMB): End function / cancel
c) Right mouse button (RMB): Context menu (you can right-click on an icon, a part, the
drawing area, a dimensioning, a text and numerous other objects).
Question 2: How do | select a point option?

a) All point options represented by one letter (R, A, D, W, P, N) can be selected via the
corresponding keyboard button.

b) Press RETURN key on the keyboard
c) Right-click just when HICAD suggests a point option
d) (Quick) double left-click

Question 3: How do | draw a closed, i.e. uninterrupted polyline even if various point
options are required:

a) Left-click on the drawing area and select new point option

b) Overwrite previous point option with new point option (only possible for point options
represented by one or two letters)

¢) Right-click > Polyline > Continue, and select new point option

Question 4: Which point options do | select if areference point is required?
Select “Relative-Return® (REL RET). Just press the “R* key for point option ,Relative®, then
confirm by pressing the RETURN key.

Question 5: Which types of re-use are available?
a) Clipboard

b) Drawing > Insert Part > Exp. > From drawing, Via document master
c) Drawing > Insert Part > Insert part, via DB document master

d) Drawing > Insert Part > Insert main part, via Standard Part catalogue
e) Insert Part > User Library

In this context please also note how you save parts to a catalogue, resp. to the database.

Question 6: How do | close a contour in a 3-D Sketch?

a) Sketch > Tools > Sort GE in active sketch

b) Information > 3-D, Further > Line > Open polylines

¢) Information > 3-D, Further > Line > Self-intersection

After further changes, select “Sort GE in active sketch” again.
Question 7: | want to convert a 2-D part to a 3-D part. A closed contour is required for
this. How do | make sure that the contour of the 2-D part is closed?

a) 2-D Geometry > Tools > Sort GE

b) 2-D Geometry > Change > Delete > Others > Double lines

c) Information > 2-D, Further > Line > Polyline

After further changes, select “Sort GE” again.

2-D/3-D Metal Engineering
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Question 8: How do | perform a displacement by a particular value with a displacement
vector?

Start point: Select an arbitrary point in the drawing area. End point: Relative.

Question 9: How do | change the grid in Sketch functions?

“ o

a) key: refine the grid; (e.g. 5 mm steps instead of 10 mm steps).

b) “+” key: coarsen the grid; (e.g. 50 mm steps instead of 10 mm steps).

c) Space bar: Direct value entry.

Question 10: How do | convert a HICAD drawing to a graphic?

a) CTRL + C > Select format and size > Select detail / Select background colour
b) CTRL + W > Select detail / ...

¢) “PRINT* key

d) Activate the “Drawing” tab and select Save/Print > SaveAs > Conversion > Create
Enhanced Metafile (EMF). You can also select a superordinate part with a right-click.

Question 11: How do | load the automatic “10 Minutes AutoSave” option?

Drawing / Open / Local Disk / hicad / temp / switch to “SZN” extension in the textbox ,Files of
type“ / select hicad_N21. During this process, N is the number of the drawing on which you have
worked. If you want to load the drawing represented by the third thumbnail in the ,Switch
drawing “ tab, load hicad_31; if you have worked on the drawing represented by the first
thumbnail, select the drawing hicad_11.

Question 12: How do | exchange the ISD logo in the drawing frame with my own
company logo?

a) Drawing > Insert Part > Insert drawing frame > Do not complete title block > select a
frame, e.g. DIN AO > insert this frame in your drawing.

b) In the “2-D Part structure” tab of the ICN, right-click on the name of the drawing. Select
the “Auxiliary parts On/Off” function, then select “Auxiliary parts On”.

c) Delete the sub-part with the old logo and create a new sub-part (e.g. with the name
“Logo”) below the “SCHRIFE” entry. Draw the new logo there, e.g. with lines, texts etc.
You can also create a new sub-part to the part “Logo”, draw a company logo as a
closed contour there and hatch it with very narrow hatching line spacing (e.g. 0.05 — an
example for this would be the “HiCAD eye” symbol). Save the part “Logo“ as Part.

d) Activate the entire drawing frame and save it as 2-D part without database.

i) with the name "DINAQ“ suggested by the computer, if you are creating a
frame for your own company
i) with a different name, if you are creating a frame for a customer, for whom

you regularly create drawings

e) Now load, one after another, frames DIN-A1 to DIN-A4. For each of them you can
delete the sub-part with the old logo and load your own company logo saved in step c),
as a sub-part to the part ,SCHRIFE®. Then continue with step d).

Question 13: How do | achieve that HICAD does not suggest any links when loading a
drawing from the database?

During part-oriented working you assign a part master to parts and drawings. Drawings are
typically loaded with links in the process. During document-oriented working you can switch off
the suggested links permanently by setting the following entry in the system file ALGPAR.DAT
to 0:

Use Helios/HICAD default configuration - Helios/HiCAD-Standardlésung benutzen.

8 2-D/3-D Metal Engineering
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4 Metal Engineering-Specific Terms

The section below lists and explains the Metal Engineering-specific technical terms that will be
used in this training. These are as follows:

Inserts

Glass panes, windows, doors, casements etc.

Facade

The planar, glazed area of a glazing construction.

Glass

All glass types, e.g. single glass panes, insulating glass etc.

LogiKal
A facade planning program by the company ORGADATA.

Mullions

The vertical metal beams in a facade.

Transoms

The horizontal metal beams in a facade. These are connected with the mullions or with other
transoms.

Beam/Profile group

A set of several individual 3-D beams and/or profiles that can be created and processed
together (e.g. mullions/transoms complete with cover strips, sealings, etc.).

Beam/Profile cross-section

2-D cross-section of a set of individual beams/profiles (e.g. mullions/transoms complete with
cover strips, sealings, etc.) that form a beam/profile group in 3-D when being inserted.

Glazing construction

All different types of glazing constructions, e.g. facades, winter gardens, translucent roofs,
windows, doors etc.

2-D/3-D Metal Engineering 9
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5 Pre-Settings: General Notes

5.1.1 HiCAD - Parameter Configuration for Glazing Constructions

For this training the Metal Engineering option needs to be activated in the HICAD Parameter
configuration for the user and the workstation.

HILAD Parameter Configuration - User Settings HILAD Parameter configuration - Work station settings

~
Do ot ume templates " Do nal use inmplains:

1% Usn 150 storwdord lormplole

% Lz IS0 staredond besnpiale:

™ Mecharical Ergnesing (gl ™ Mechancal Enginesting © HicAD

@ Srael Engrnering £ i @ Sied Cngnssing & i

" Motal Enginosang £ Metal Engnaesng £ | M5 Pliothis
£ Plant Engineeting I Plant Erginesiing : -

[ HICAD /HELIOS Disfsul Sohition

I = 300 [BIM)
[F HCAD / HELID' Diefak Soutises

[ Stanes Confiurstion

1 U oo bemmlate

Configusstion [150 detenie j_l Configuration 2150 deted ﬂJ

Lewe | LTI ||

The parameter configuration can be changed subsequently with the programs <hicad
installation directory>\exe\ ParKonfigComp.exe (Workstation configuration) and <hicad
installation directory>\exe\ ParKonfigUser.exe (User configuration).

5.1.2 The “Metal Engineering” Tab

To access the functions for 2-D and 3-D Metal Engineering as well as for Facade Engineering,
you need to open the Metal Engineering tab on the HiCAD Ribbon. To be able to do this,
select Settings > Ribbon categories and activate the Metal Engineering checkbox.

HICAD Ribbon categories
[Ribbon category ]

Orom

Drawing

3-D Standard
heet Metal

Steel Engineering

Metal Engineering

Metal Engineering tab Settings

O P+ Library
O r+ID Symbol Editor
O HELios POM

HICAD - C:\HCAD _en'szenen DRAWING, SZA

Drawing  3-DStandard  SheetMetal Steel Engineerir (SCEINIBUEE 3-D Dimensioni  Sketch Views 2DPat  2.DGeometry 2-DDimensioni 3-DFFS  Information

o P £ Beam ~ i, Item. e T e MR e o BT o e | o — T | Facade
B i ek W5 Py = gy P k|2
= = Glass  #E Grid i Exchange | = =4 4] Facade
Assy. | Mullion Muliion Part Glass Skeich Lengthen || Sesling  Foll Change Edt.. J Settings Foils Change Sheet Attr. || Conv.
5 = type = S mnsert  §E Sketch & i Export = - - 11 Sect. -
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5.1.3 Novice Configuration

The so-called Novice configuration makes it easier for you to learn how to create and process 5
beam/profile groups. New users will be safely guided through the options. To activate the gj
Novice configuration, open the Drawing tab and select Others - Extras - Novice =

configuration. \
E Novice configuration
~ General . \*}'\f ,@

‘ Default identification mode

Extras |Plugins

~ 3-D Sketch Y Extras
Right-click to use active surface as plane [ vES -| 5
Prompt for plane when creating new sketch | YES - | @] Novice configuration
Default plane for new sketch [Wo - |
Rotate sketch parallel to screen, in model view | NO - |
- 3-D Model S
AutoDatect assembly/processed part ['vES - |
Rotate model view to perspective in preview | NO - |

Save as default setting

[ oK H Cancel |

5.1.4 Lock Views in Sheet Area 5

The locking of views prevents an unintentional rotating of views during drawing creation. This
option allows you to work in the same way as in 2-D while still using the benefits of 3-D design.

Lock / unlock views manually:

= Right-click view frame (pink dotted frame around drawing BoEs®0 O3
object) and select “Transform” > “Lock projection” Others ’
(“Unlock”). Edit

BPHSRS S

7

Others »

Transform
0RAR Y%

P
e i) ’

Global setting for view configuration <hicad installation directory>\exe\ ISDConfigEditor.exe.

5

] & 150 Confouration cdtor HCAD [C:\Programbat\isp software und Systeme\HICAD 2012\icADclgdb] =
i File Process WView Extras ISD
[<] e User Administrator -m B
= ‘jHimD Description Value Comment
=] [iE] Active configuration (Base configuration) | Automatic locking of new, orthogonal views in sheet areas 0 1: lock, 0: do not lock
El £ General Automatic locking of new sectional/detail views in sheetareas 2 1: Always lock, 0: Neverlack, 2: Apply settings of original view

[ Calculations

[ Drawings

[ HICAD-HELIOS interface
[ Interfaces

|7 start configuration

[ system settings

=] Y
= Hidden Line
=] Weld seams
[ Modules

lj| configurations
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5.1.5 “Group Snap” Mode

If this snap mode has been activated, Steel Engineering functions and beam/profile functions
will not just refer to the selected object, but to the entire corresponding beam/profile group (if
any). This facilitates the processing of complete beam/profile groups (activate, transform, clone
etc.) significantly.

You activate the “Group snap” mode via the transparent
toolbar, by right-clicking the 2" icon from the left and selecting
“Group”.

3-D Identification

Options
“ ” - EIEmEnt

If you want to make the “Group snap” the default setting, open

the Drawing tab and select Others > Extras > Novice Object

configuration. In the dialogue, select “Default identification Group

mode: Group”.

6 Glazing Construction with User-Defined
Beam/Profile Cross-Sections

6.1 Create User-Defined Cross-Sections

It is possible for users to create their own beam/profile groups
and apply the available Metal Engineering functions to them as
usual.

In this exercise an imported mullion from the SCHUCO series
FW50+ is transferred and processed.

2-D/3-D Metal Engineering
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6.1.1 Create 2-D Part Structures

The definition of a user-defined beam/profile group takes place via the creation of a 2-D part
with the part structure as shown in the screenshot below.
Options for part creation can be found on the 2-D Part tab of the HICAD Ribbon.

Create structure of user-defined beam/profile  Eoemmmnne

S Loy o B i B 20 2 8 bl
W 2D-PROFILESTRUKTUR
[H-ma View 2

Main beam/profile (e.g. SC FW 50+ mullion)

m Profilel ioma® 3D sheet
m  Profile2 B R 5C FW 50+ =02 JMullion} £
u Profiles 0 i & 5C 244293 {z.Gasket 9mm rh} {

R | I & 5C 244293 {z.Gasket 9mm rh} {
= Profile ... . . P | I & 5C 112720 {Cover cap 15mm} {
m Glass ... Glass insertion points || - &} 5C 244582 {gl.Gasket 3.5mm rh} {
= Contour ... Simplified contour of the | - W 5C 244682 {gl Gasket 3.57m rh}

. | . & 5C 112710-WK2 {Andruckprofi Gest, Wiz}
entire beam/ proflle ----- &} SC 224809 {Isalator Prof 25mm}
m Cutout ... Notching contour for | - & 5C 322280 {Mullion 105mm}
Hae tA he attacrhed | &} cLASS
beams/profiles to be attached | & SC 266047 Butyl Tape 40 mm) O
----- &} CONTOUR
----- & cuTouT

2D-Part structure JEEIEET (i la{l]y]

m  EXACT geometries will be created for each single cross-section in the 2-D part EXACT.

= SIMPLE geometries will be created for each single cross-section in the 2-D part
SIMPLE.

m  CONTOUR geometries will be created for the complete cross-section in the 2-D part
CONTOUR.

It is recommended to use only the exact geometry of the single cross-section, and one contour
for the complete cross-section. Firstly, the creation will require less time, and secondly, it will be
possible to switch the representation types depending on the respective view.

For “View all” views, the contour representation will often be sufficient (which also allows a
higher quality of representation), whereas in sectional views an exact representation would be
required.

Copy the Part name to the Article number field
m |tis easiest to copy it in the Part attributes window.

m For the sake of clearness, the Part type can also be specified. It is displayed in the ICN
and makes an identification of the parts easier.

=
Part name ISC FW 50+ =02 BOM-relevant -
Aficle number |SC FW 50+ Qty. per part I

2-D/3-D Metal Engineering 13
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6.1.2 Import Cross-Section Geometry
Insert the file SC FW 50+ =02.FIG from the directory HICAD\Szenen in an empty drawing file.
Take the contours of the 2-D figure over into prepared part structure, as described in 6.1.1.

To do this, open the 2-D Geometry tab and select Tools > Sort GE > Apply/Copy > Take
over/Copy GE to active part

i
B BRA 5 FPFTIS CRHHIG :f}H

—— Take over GE to active part, lines (2-D)
o

6.1.3 Clean Up Cross-Sections

Check the geometries for errors and clean them up using the 2-D standard functions if required.

You should consider the following:

= Avoid collisions of 2-D parts (otherwise the colliding edges will be hidden in 3-D Hidden
Line representation!)
Delete double lines
Delete overlaps

Close corners g
Close polylines _—1 O ’ L ‘
Simplify contours where possible _@_.' N
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ing=+Text Sketch Views 2-D Part 2-D Geometry ] I 2-D Geometry 2.D Dimensioning=Text 3-D FFS Information
L jrmmr e g L] jrm T L : n
XY N R TR TR
= . . . jLsSS. H a JUBSSL H a
|Trlm ‘Pumt UrE S i Sy",‘b”' D,EI' MS“ | | Del. | Move Move Rotate MirrorLin MirrorPt Move Move Rotate MirrorLin MirrorPt
Lines
Delete
Lengthen/Shorten
General
¥
By value
_}<_ Inrectangle
- ®
_h: Via value
v =% Paiyline
Modify vy
Cha i adius 4

_; Via attributes
£

j? ; List
Others Delete

Divi b Points Line fragments
4 1 <0001
% Merge polyline = Individual *—'X— Allin part

2| Close corner, internal corner

-

s
-
a
<0001
M, t o
#\%2 sraepa 2( In rectangle ﬁ— All
Further =
m
’ =" Allin part =
3 Allin part
.

* Align=Close GE
o
ﬂ Rectangular cutout
Z_ Trim to rectangle
Fillet

Many geometries of older drawings contain small, approximated circular arcs. If possible, these
should be replaced by circular arcs running out tangentially, in order to obtain a higher quality of
representation of the views.

2x
.\'X— Delete identical lines, active part (2-D)

F13
a)(— Al

Fitting points in part

%, ®. % O
be | B B
=

6.1.4 Part Attributes / BOM Relevance

Assigning of attributes, Option 1

To set the required part attributes, open the Metal Engineering tab and select Metal
Engineering, 2-D - Define cross-section properties.

The relevant attributes will be queried and assigned to the 2-D part.

[#] Part attributes

BOM-relevant [

e F Lo [ — Adticle number |SC 322280
T iﬁ Width Height |
Foils Change Sheet  Attr, Weight per length |—264 Avoirdupois per length l—
- - -

Surface per length 0.46
Substance/Material | Light alloy _I

Type of use ISupport profile _l

Designation 1 |

Designation 2 |

Comment [SC Fw 50+ =02

System notes |
OK Cancel

Now use this function to assign the properties for the single profiles and the “superordinate”
part.

The corresponding materials can be found in the Civil Engineering materials folder.
= Activate the BOM-relevant checkbox if desired.
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Assigning of attributes, Option 2

To set the required part attributes, open the Steel Engineering tab and select Further
functions = Settings = Series cross-sections, Assign attributes.

The relevant attributes will be queried and assigned to the 2-D part.

i
Fartname [SC 322280 BOM-relevant 2

Atticle number [SC 222280 aty.perpart [T
temno. [ Anglepotomiett-xz [
weignt [ anglepotomtett-vz [
wian [ Anglebotorniright-x2 ||
Length li Angle bottomiright - YZ. l—

Height l— Quantity 1 l—
Dimension 1 l— Quantity 2 l—
‘Substance/Material [Light alloy Quantity 3 |
Type of use |5upport profile J
Designation 1 |
Designation 2 [

Comment [SC Fw 50+ =02

System notes |

Parttype [Mullion 108mm
oK Cancel

Now use this function to assign the properties for the single profiles and the “superordinate”
part.

The corresponding materials can be found in the Civil Engineering materials folder.
m Activate the BOM-relevant checkbox if desired.

6.1.5 Notching Contour for Attached Beams/Profiles

The geometry for the notching of attached beam/profile groups is defined
as a closed polyline in the part CUTOUT.

In the 3-D beam/profile group, the CUTOUT figure is invisibly included.
To create a notch, use the same-named Steel Engineering functions.

3-D Ff

2D Part 2-D Geometry 2-D Dimensioni

Views

Sketch

SCONGBIGEEN Metal Engineeri 3-D Dimensioni

7 ﬂStiHeners ™ Rect. ~
a FramSol . > Glass =
From5kt Grat. -

-// s Point
“’ # Divide -

Length Total
i Union

o Edge 7T
®¥ outer %
g;f Surface ;,E?

wlengthen w/olengthen

gle

2-D/3-D Metal Engineering



Glazing Construction with User-Defined Beam/Profile Cross-Sections

6.1.6 Glass Insertion Points

The definition of glass insertion points takes place via the creation of appropriately numbered
isolated points in the part GLASS.

The point numbers are defined as follows:

@D

0

@D

Points 10 and 20 define the glass inset
Points 11 and 21 define the glass insertion direction
Points 12 and 22 define the glass thickness

Points 14 and 24 are required for the option “Change glass in
insert”. These points are not mandatory.

Optional is the definition of Points 13 and 23. Between Points
11 and Point 13 you can define a tolerance (as for Points 21
and 23). The definition of these points is not mandatory.

6.1.7 Contour Geometry for Contour Representation of Complete Beam/Profile

Groups
Switch drawing R x
DRAWINGT DRAWINGZ 2D-PROFIL... |
I2[Lhrl structure ax
G Do B e s 22 23 0 4]
f-me® 2D sheet -]

B8 5C FW 50+ =02 {Mulion}
W} SC 244293 {z.Gasket 9mm rh} &

----- W} 5C 244293 {z.Gasket Smm rh}

----- W 5C 112720 {Cover cap 15mm}
W} SC 244682 {gl.Gasket 3.5mm rh}

----- W} SC 244682 {gl.Gasket 3.5mm rh} £

----- W 5C 112710-WK2 {Andruckprofi Gest. WK2} {1
&} SC 224809 {Isolator Prof 25mm}
W sC 322280 {Mulion 105mm} {

..... & GLASS
& 5C 283047 {Butyl Tay
&} CONTOUR

4]

In the 2-D cross-section of a beam/profile group,
; create the part CONTOUR, and draw the outer

i

contour for the complete beam/profile group in the
part. Also draw the glass insertion depth here.

In this way, the created 3-D beam/profile groups
can be displayed as contours by means of the
function All Metal Engineering assemblies >
Contour representation.

H

This does not only increase graphical performance,
but also leads to optimised representation in
overviews and easier element identification in 3-D
drawings.

oL |

xchange Export Contour Exakt

Settings = Change

part type

6.1.8 Define Insertion Axis

On the desired point, create an isolated point in
the superordinate beam/profile. Via this point, the
complete beam/profile can be moved to the origin
of the coordinate system (A 0 0).

When you save the drawing, the origin will define

the insertion axis.

It is recommended to choose a point on the inner

or outer glass plane.

2-D/3-D Metal Engineering
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6.1.9 Save Beam/Profile Group to Catalogue

In the Catalogue Editor you can create your own tree structure under =@ Factory standards

Factory standards\Series\Metal Engineering\ ... . 3 W Usermateral

=@ Seres

EQ Mstal Enginsering
Mulicn
Transom

Isd Example
\..[F= Isd Example Dicf

To do this, open the Steel Engineering tab and select Further functions - Settings 2>

Series cross-sections - Save as catalogue part -
Save as catalogue part

Select the part (entire profile at isolated point)

Specify the storage location of the 2-D file (e.g. Catalogues\Series\Metal
Engineering\...)

Choose the desired table of the catalogue

Enter the corresponding attributes in the input fields

|

Fiﬁms IMain series j Availability

Bz [sc Furso+ =02 Description for selection when inserting the part in
HiCAD

BEZEICHNUNG | )
Value for Article number

k\IAME IBaurahen'nSC FW 50+ =02.FIG Storage location of part

e E 1= Fixed 2-D/3-D part (Default)

ICON | sC Fw 50+ =02

Name of icon file in Image sub-folder

EDKUKDPFID [
EDmREﬂD 1

AUTEILKOPFID |
BAUTELREVID |1
[FIRMA | i
Beam/profile manufacturer
ISERIE | , ,
Beam/profile series
H [0 Beam/profile height
faLAS | Glass thickness
fo Inclination angle
| Comment

Cancel
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6.2 Insert User-Defined Beam/Profile Cross-Sections

6.2.1 Free Insertion

The free insertion takes place in the same way as Beams+Profiles - Fitting orSons
the insertion of Steel Engineering beams, with the
known functions. The insertion points can be
picked via already designed parts, or can be
constructed with the help of point options R, P, etc.

6.2.2 Insertion with Sketch

The insertion via sketch takes place in the same Beams+ Profiles - Fitting options
way as the insertion of Steel Engineering beams,

with the known functions. Prior to insertion you | | |
N

need to define a processing plane. The
beam/profile will be placed with its insertion axis into the processing plane.

6.2.3 Insertion Perpendicular to Processing Plane

The insertion perpendicular to processing plane Beams+Profiles - Fciing options

takes place in the same way as the insertion of — —
Steel Engineering beams, with the known | | | |
functions. Prior to insertion you need to define a
processing plane. The beam/profile will be placed perpendicular on the processing plane, via

specification of one start point and a length.

6.2.4 Insertion on Grid via User-Defined Beam/Profile Cross-Sections

In the following chapter, user-defined beam/profile cross-sections are to be placed on a Metal
Engineering grid (use Metal Construction plugin). Prior to this, the steps described in Chapter 8
Create Facade via Metal Engineering Grid (Metal Engineering Plugin) need to be
performed.

1. The creation of the grid is described in Chapter 8 Create Facade via Metal
Engineering Grid (Metal Engineering Pluglin). First, perform the steps in this chapter.

s ] ~~ ~~
L L
Mullion Mullion Transom fransom

- -

2. Now use the Mullion or Transom from catalogue =
function to place the beams/profiles on the sketches. '@
You can also use “collection” functions for the selection || assy,.
of equally aligned axes. -

- CTRL + Left-click = Collection/deselection of individual (sketch) axes
- SHIFT + Left-click = Automatic collection of equally aligned (sketch) axes

3. Right-click to open the HICAD dialogue. In the Metal Engineering folder you can find
prepared beams and profiles.

4. Use the Cut-outs option for the notching of the mullions/transoms: On the Metal
Engineering tab, select Grid - Assy. - Cut-outs.

2-D/3-D Metal Engineering
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5. The automatic insertion of glass panes across the complete |Metl Eno. oria
facade can be performed via Metal Engineering > Grid > [®*=
Assy. > HiCAD glass. 7 Templates

Glass

6. Here it is important that you define a suitable glass pane, or | HiCaD olass
select a glass pane with the previously specified glass thickness L

(see Chapter 6.1.6 Glass Insertion Points) m Logikal glass

Grid connections
% Via HiCAD Design Variant

EVA

7. Create several views in the Sheet area and familiarize yourself
with the representation options.

Via LogiKal

<«

i Trim

N
R

Mitre cuts

7/ Creating Glazing Constructions with LogiKal
7.1 Pre-Settings for Beam/Profile Groups via LogiKal

Before you can use the interface with LogiKal, you need to define some pre-settings. For
example, you need to specify where HiCAD can find the LogiKal installation, from where the
beam/profile cross-sections will be loaded etc. ...

7.1.1 Interface Settings (Registry Entries 32/64 BIT)

To ensure a proper functioning of the interface between HICAD and LogiKal you need to make
the following settings in the Registry:

m Click the Windows Start button, enter regedit in the input field at the bottom and
confirm with ENTER.

m Create an "Orgadata” key under HKEY_LOCAL_MACHINE/SOFTWARE, with the

string ab|logidl REG_SZ  C:\LOGIKAL\LogDlis4.dl

= Also create an “Orgadata” key under
HKEY_LOCAL_MACHINE/SOFTWARE/WOW6432Node, with the string

ab|LogiDll REG_SZ C:\LOGIKAL LogiDll.dl

2-D/3-D Metal Engineering
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7.1.2 Metal Engineering Settings >

&
=l
The Metal Engineering settings are used for the optimisation of LogiKal beams and profiles. To
access the setting options, select Metal Engineering = Process, LogiKal 3D - Metal .
Engineering Settings. e
/'_/. AT _/?I

txchange Export | Settings

Automatically recoghise beam/profile series [ TSR rET :] [ ST :]

) 2-0 insertion @ 3D inzertion

[ ] Create Exact and Simple IFine v|

Create Contour
Corect 2-D cross-section

Process 2-D cross-section with HCM IZD
[] Switch HCM radiuz canstraink OM

Tolerance foropen palylines I'I @ ialass, top edge ~) Beam/Prafile, battom
Tolerance for sorting IU-1 *) Glass, bottomn edge
[] Replace small arcs with line Frocessings
IU-5 [T] Generate processings for Logik.al connections
[] Approximate polylines as circle Process rubber parts exactly
|1 55 0 Set azzembly of zeries beam to 'BOM-relevant’

51 Uzer guidance Logikal IGe[man VI

0.001 Logikal number - 10453458

[ Defar | [ ok | [ Cancel |

= Load from... Use this button to load the beam/profile series to be inserted from the
HiCAD/sys sub-directory of the HiCAD installation, and to explicitly specify insertion
functionalities.

= Automatically recognise beam/profile series... When you insert a beam/profile series
via LogiKal, this will be recognised in HiCAD, and the insertion will be optimised
appropriately. The insertion options for the different beam/profile series are managed
via the buttons in the upper window area.

m  Cross-section, general... As HiCAD uses the beam and profile library of LogiKal
(Logidll.dll), and these 2-D cross-sections do not always have a closed contour, these
2-D cross-sections can be auto-reworked with the “Cross-section, general” option.

= Simple... Use this option to additionally auto-create a SIMPLE figure. You can switch
between the SIMPLE and the EXACT figure using the Steel Engineering functions. (see
also Chapter 7 Representation Options)

m Fitting point... Here you define the fitting point of the beam/profile group. Normally, this
should be “Glass edge, top” or "Glass edge bottom”, to ensure that the correct glass
plane will be used when the mullions and transoms are inserted.

m  Processings... Here you define whether processings should be generated on mullions
and transoms for LogiKal notchings.

m  Set assembly of series beam to BOM-relevant... The single beams and profiles, such
as mullions/transoms, cover strips, pressure plate profiles, etc... are always BOM-
relevant. Use this option to set also the superordinate assembly to BOM-relevant.

m User guidance LogiKal... Here you can select the language for the LogiKal window
opened in HiICAD.
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7.1.3 Simplified Beam/Profile Cross-Sections in the HICAD Catalogue

The insertion of LogiKal beams and profiles normally takes place via the Logidll.dIl and uses the
exact beam/profile cross-sections by LogiKal. As these cross-section may contain gaps or
double lines, you have the option to save simplified/corrected beam/profile cross-sections in
your HiCAD installation, at ...\Catalogues\Factory Standards\LogiKal.

When you insert LogiKal beams and
‘8 AP oI oo profiles, HICAD will check whether the
corresponding figures are available in
Organisieren *  In Bibliothek aufnehmen +  Freigeben fir +  Brennen  Meu the \Catalogues\Factory

A Favoriten Name * standards\LogiKal directory and will
| 01_Daten « Nichtangegeben(@) —— use them. If the figures do not exist, the
M Desktop | FoR exact figures by LogiKal will be used.
%:fcllzoads e To ensure that always the newest beam
| LOGIKAL o RAL and profile cross-sections will be used,
] Zuletzt besucht $ 5C they will obtain an appropriate
b 5C AWS timestamp.
.ﬁ] Bibliotheken || sC 224388.FIG
=] ilder | |5C 224333.FIG.DBAZ
3' Dokumente %] 5¢ 238400.F1G
g :::il;s || 5C 298400.FIG.DBAZ

7.2 2-D/3-D Interface with LogiKal
7.2.1 2-D/3-D Import of Individual Beam/Profile Cross-Sections

The Insert facade profile function in the LogiKal 3-D function
group enables you to use and process the beam/profile systems
of all facade system manufacturers available in LogiKal.

ﬁ : Insert facade profile (3-D 5E)

= On the Metal Engineering tab, select Logikal 3-D - Insert facade profile.

m In the LogiKal dialogue by ORGADATA you can then configure the desired beam/profile
cross-section.

Curtain Wall Combination with Glazing [c:\hicad_en\temp\logixmigroup.mi] x|
System: | Schiico Pw B0+ w |
Selection | Standard w | T_l,ge \?\uf"iioo[zten
Glazing Bead Y ariation: |Standard v|  DOuter Carner

" Inner Carner

Angle of Folding: ID K

Subspstem: | Standard w |

Mumber of Glazs P £
umber of Glass Panes (* Bilaterally falded

Tom: |1 3‘ Bottom: |1 3‘ = Folded ta the [eft
' Falded ta the right
Glasz Configuration Tap: |32 ID ID ID ID T

Glazz Configuration Bottol? IU_ IU_ IU_ IU_ ]

Type: | tullion v |

g |t | mee|  Foreanam
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Preview Fulion 105mm: 322280 v

Isalatar Prof 25mm: 224809 v

Butyl Tape 40 mm: 288047 v

Andruckprofil Gest WEZ: 1127104wk2 v

Frafile & 112720 v
110240 Covercap 17 Founded & = F
110250 Cover cap 26 Rounded
110840 Cover cap 20mm
110850 Caover cap 25mm
110860 Cover cap FwS0/dk
112720 Cover cap 15mm L O
122380 Cover cap I ‘ ,
160620 Caover cap 12mm
202285 Covercap50x15
202286 Cowver cap 50 = 20
306140 Cover cap Prof 50/25
07790 Fuwhl Deckschale 35 T e

Cover cap 15mm

of Dack | Einish > | gose|

"%RGADATA

m  After clicking Finish the beam/profile group can be inserted in your drawing with the
standard Steel Engineering functions.

After inserting the beam/profile group in the drawing, a main part (which is not BOM-relevant,
see 7.1.2 Metal Engineering Settings) with sub-parts such as Sealing, Pressure plate profile,
Mullion etc. ... will be created in the 3-D Part structure of the ICN. These sub-parts are BOM-
relevant and contain all BOM-relevant information.

3D-Part structure o x
(3 o 1o Byt B2 2o 53 B2 4]
E-P  5C FW 50+ =02 {Mullion} {0} |

-----  @D5C 244293 {z.Gasket Imm rh} {0}

----- ¥ @DISC_2344293 T7.Gasket Smm rhy 104}

----- F5#5C 112720 {Cover cap 15mm} {0}

----- ¥ D5C 244682 {gl.Gasket 3.5mm rh} {0}

----- T 5C 244632 {gl.Gasket 3, 5mm rh} {0}

----- 0 @5C 112710-WK2 {Andruckprofil Gest. WKZ}
----- }( W SC 224309 {Isolator Prof 25mm} {0}

----- ¥ @5C 322280 {Mullion 105mm} {1}

----- ¥ 5C 238047 {Butyl Tape 40 mm} {0}

i R (i eV 3D -Part structure

Besides the part structure, beam/profile manufacturers, beam/profile systems, designation, e
article number and part type will be generated into the part attributes and can be displayed in
the ICN.

The glass insertion points and the cut-out figure are invisibly included in the part structure.
They will be automatically evaluated during glass insertion/notch creation.

v

2-D Insertion

The option Insert facade cross-section in the LogiKal 2-D function | — = [—
group enables you to use and process beam/profile systems in 2-D, from YRR

all facade system manufacturers that are available in LogiKal. S (RERRE|((EEGE ) SR
= On the Metal Engineering tab, select LogiKal 2-D - Insert facade cross- L X =
section.
11

m  The beam/profile cross-sections are configured in the same way as the 3-D '-.__..
beams and profiles. -
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7.2.2 Exchange Beams/Profiles via LogiKal

7 If beams and profiles are modified during the | «» @ < |8l o 4. = o
57 : . : o |97 W% M| PR BE % B B OH

<L ConStrUCtlon phase by an arChlteCt, pFOJect Supewlsor Change Edit.. Notch [ExchangefExport | Settings Change Contour Exakt
EEETEE or structural engineer, one or several beams/profiles . : Paroee

can be exchanged via LogiKal.

Right-clicking the items in the Exchange via LogiKal Exchange
selection list allows a multiple selection of beams and
profiles.

|Exd'|ange via Logikal (Facade prdﬁle]L
Beam type I

This option is only available for 3-D beam/profile groups.

7.2.3 Mullion/Transom Connection via LogiKal 3-D Interface

You can apply mechanical processings in HICAD to beam/profile combinations selected via

% LogiKal in order to create mullion/transom connections. The accessory parts will be created as
Motch dummy parts with BOM data.
Caution:

When the connections are created, it will not be verified whether they actually match the
current_specifications _of the manufacturer! Therefore, the created connections must
always be checked by the user and, if required, adjusted manually according to the

beam/profile manufacturer’s specifications.

m To create mullion/transom connections via
LogiKal, select Metal Engineering = Process,
LogiKal 3-D = Notch series beam, via LogiKal.

Change Edit... § Motch JExchange Export Settings |

m First select the
transom, and
then select the
mullion.

= After this, you
can choose the

desired
. 322390 to 322280: ¥.PEZ [Kropt PEZ Terb.] v]
connection T127105K2 1o 112710WKE LB Leiterbauweios Al
Situation Via the 160B20 to 1127200; KMOPF Kropf T-erh.
. KMOPF+5D Fnopf T-Verb.+5toldichtung
LogiKal KPEZ Kriogf P2 TWeit,
H K. PEZ+SD Fnopf PEZ T-Verb. +Stobdichtung 205 0B2
SeIeCtlon FEDER Federbolzen T4erb. .
dialogue. FEDER4SD  Federbolzen TVerb.+Stobdichtung
EF1 Eigenf. 175390
EF1SD Eigenf. 175390+5taRdichtung
EF2 Eigenf. 175750 s A
EF25D Eigenf. 175780+5taldichtung 226155
EFK1 Einenf kraftschiiizsio 175780 5 % 226 173 . ]
The following items are induded: d
205082 c.5unk scr.b4.8x30
205827 Spec.Screw 3.9x15
217585 Seal
225155 t-Cleat
Length calculation: A-20mm ﬂ
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m After selecting the connection elements, the connection will be automatically created,
complete with all processings and accessories.

3D-Part structure a %

# @SC 244293 {z.Gasket 9mm rh}} {0}
F @5C 244293 {z.Gasket 9mm rh}} {0}
# @SC 112720 {Cover cap 15mm} {0}
F @)sC 244682 {gl.Gasket 3.5mm rh} {0}
F DSC 244682 {gl.Gasket 3. 5mm rh} {0}
# W5C 112710-WK2 {Andrudgrofil Gest, WKZ}
 @5C 224809 {lsolator Prof 25mm} {0}
¥ @SC 322280 (Mulion 105mm) {0}
 5C 283047 {Butyl Tape 40 mm} {0}
. : 4]
= WSC FW 50+ =02 {Transom) {0}
F 5C 204533 {Glaz.Gasket 3mm rh} {0}
 @sC 204533 {Glar.Gasket 3mm rh} {0}
#F @5C 150620 (Cover cap 12mm} {0}
F @sC 244682 {gl.Gasket 3. 5mm rh} {0}
F @sC 244662 {gl.Gasket 3. 5mm rh} {0}
F W5C 112710-WK2 {Andrudqwofil Gest. WK2)
¥ @)5C 283047 {Butyl Tape 40 mm} {0}
F @WSC 224809 {Isclator Prof 25mm} {0}
¥ $5C 322390 {Transom 55 mm} {0}

& & @ knopf P2 T-Verb, {knopf PBZ T-verb.}
T 5C 205082 {c.Sunk sor.bd,Bx30) O
SC 205827 {Spec.Soew 3.9x15)
SC 205827 {Spec. Soew 3.9x15)
SC 217585 {Seal} O

SC 226155 {t-Oeat}

F RSN UL T 30-Part structure

g (1)SC FW 50+ =02
& s (3)Notch LogiKal
4= (2) - Insertion Position ---

= For mullion/transom notchings, a multiple selection of transoms is possible. Please note
that the “Group snap” mode needs to be activated for this. Press and hold down the
CTRL key and left-click to select, one after the other, all transoms that should be
attached to a particular mullion. A selection list is created in the ICN, and all selected
beams are highlighted in green in the drawing area. Then, choose the Notch via
LogiKal function, and finally, select the mullion with a mouse-click. The connections
will then be created automatically.

S

To change the position of the transom on the mullion, you need to delete the feature log entries
for the notchings on mullion and transom.

I (S}Tﬁmtos-DW Right-click feature log entry and
& (4) Notch LogiKal

4= (2) - Insertion Position -—- select Delete

HCM  Properties Graphic
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7.2.4 Transfer of Beams/Profiles to LogiKal

_ If you insert individual beams and profiles via LogiKal in HICAD and process them, you have the
f | option to export the beams/profiles including all processings and accessories to LogiKal.
L

m On the Metal Engineering tab, select Process, LogiKal 3-D =
Beams/profiles+facade -> LogiKal

A AL

Change Edit.. Motch Exchangs

.

g Beams/profiles <facade -> LogiKal [3-D SE}

= The beams/profiles can be collected with left mouse clicks in the drawing area or in the
ICN. You end the selection by pressing the middle mouse button. An export file
(HICAD_logiKal-Export.xml) will be created in the ...\temp directory of the HICAD
installation.

m This HICAD_logiKal-Export.xml file can be imported to LogiKal. For this you need to
start LogiKal and activate a project. The “Import from file” option will then be available.
Go to the HICAD\temp directory and select the file HICAD_logiKal-Export.xml.

% Import from ~ - Edi x|
Project Iﬁ Findin:  [C:AHICAD_enbtemp <]« @ ® e

Position Library
Element Template

File Na | Sizel Type ﬂ

HICAD logi abE sport smi 168 UL Doknen g
o | _*IJ

File Hame: IHIE.-’-\D_IagiKaI-EHpDrt j Load |
== File Type: |3D-F'asiti0n-|m|:lart [*.=ml) j ﬂl

To be able to use this option, the 3-D Interface of the company ORGADATA needs to be
activated.

- If any changes are applied to the HICAD drawing, the beams/profiles must be re-exported to
LogiKal.

vk
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7.2.5 2-D/3-D Import of Existing LogiKal Items

If window or facade elements have already been created in LogiKal, these can be imported to
HiCAD in 2-D or 3-D.

m Import of a 2-D facade element

Select Metal Engineering = LogiKal 2-D - Insert facade + inserts from existing LogiKal
project (2-D). The project management dialogue of LogiKal opens, enabling you to select the
desired item.

[ Project Managesent (Demo] =il
| Emshing Fuldems Propucls ] Dokein
i=H_) <Plest Disectons TS ,7 || —
B [ Brcle B (3] Eiils _ Fed | b Rerame:
Poslion Hiied D esighon Uy | Sesm )
- 13 1 S P Bille o1

—LM062—
| —

[System S AWS 5501

L
Seitings

When the desired item has been selected, several view options can be chosen. You can decide
whether you want to import the complete view with section details, or only the view, or only the
sections, a shortened or unshortened view etc. After configuring the views select Transfer

drawing to get back to HiCAD.

EN [hicad] - Logikal 7.1.0.601

: File Export View

‘ Frevious Position ’ INext Position E@ Swap View ‘ Select Positio H Transfer Drawing | o2 Settings !
Set Section Points j Perform Section Line 435 Perform Cross Section ‘ Remove Sections ’ Perform Section !

F-yope

O S

Transfer Drawing

0 B4

Opening Angle
Master Leaf:
Slave Leaf:

-
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Pos. hiced, Quartily: 1

When importing the 2-D views you will be prompted to
specify a fitting point on the part. When making the insertion ~ J:ier 5ioro /5 755 forloge et es

in the HICAD drawing you can directly specify the correct

position. Furthermore, you will be asked to specify the T B
rotation angle and the scale of the 2-D view.

fe Changes can be made at any time using the HICAD 2-D p
: functions. However, such changes will have no effect on
the corresponding item in LogiKal. To keep changes in -
HICAD and LogiKal up to date, the item needs to be L =

changed in LogiKal and then re-imported to HICAD.

F
=

t—————FFS5: 2031
it

For the construction of drawings for approval containing
wall connections, the Metal Engineering, 2-D functions and
the general 2-D Geometry functions are available.

= F; IF &

FFSS 1087 —
} 1200 —
I ——————————-——

Foils Change Sheet  Attr.

3D = Import of a 3-D window/facade element

Before importing the element, you need to define a processing plane, into which the

@ window/facade element will then be imported. This will prevent a subsequent rotating or moving

T of the part. The import is performed according to the active coordinate system. If no processing
Pos... plane is active, the element will be imported according to the World Coordinate System.

. LogiKal elements are aligned as follows: The X-axis always refers to the width of the elements,
the Y-axis to their height and the Z-axis to their depth!

vl

To access the function, select Metal Engineering = LogiKal 3-D = Insert facade + inserts
from existing LogiKal project (3-D SE). The project management dialogue of LogiKal opens,
enabling you to select the desired item.

_lolx|
‘ Project Fiter Settings

Existing F Projects Dekete

-
S et O seww [ |
g
it escription elie

ame

[}
i
2

Copy

Mave

Properties

FOR0EE T
———1200———

oiuwng? —
— 20—

SystemSC AWS 75.5_01

Import Export
Seltings

Eiber

Select postion Close

2 positions found
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When importing the 3-D window/facade element, you will
be prompted to directly specify a fitting point on the part.
Left-click twice to directly specify the correct position
when making the insertion in the HICAD drawing.

Alternatively, you can right-click twice to place the
element in the origin of the processing plane.

Changes can be performed at any time using the HICAD
3-D Standard and Steel Engineering functions.
However, such changes will have no effect on the
corresponding item in LogiKal. To keep changes in
HiICAD and LogiKal up to date, the item needs to be = “=
changed in LogiKal and then re-imported to HiCAD. i

Changes, Option 2

o it

You can use the Edit facade + inserts (3-D SE) o e ook
Notcl change Expo

function to change the element (dimensions, glass etc.) | "9t

via LogiKal. It will be updated in HICAD immediately. Pracess, LogiKal 3-D

=
ﬁ Edit facade+inserts [3-0 SE)

Caution: When using this option, the changed facade/window element will only be available in
HiCAD, but not in LogiKal. At this point, there are two different items. In such cases the item
needs to be deleted in LogiKal, and then the HICAD item needs to be imported to LogiKal.

m The facade/window element can be exported to LogiKal with

Beams/profiles+facade -> LogiKal function. For this to happen you need to select a
part of the facade/window element, or to the complete assembly selected in the 3-D
Part Structure (confirm by pressing the middle mouse button). After this, a

HiCAD_logiKal-Export.xml file will be created in the HICAD\temp directory.

nfﬁ’|

Metal Engineering 3-D Dimensioning+Text

A AAA

Views 2-D Part 2-D Geometry 2-D Dimensioning = Text

| part type

%, Logikal 3-0

B HicAD_logikal-Export.x
|| HICAD_logiKal-Export.xml. 3.position.blb 13.11.2012 09:51 BLE-Datei 185KB

= To perform the import, start LogiKal first. Use the LogiKal function Import from:

import the HICAD_logiKal-Export.xml file from the HICAD\temp directory. The xml file
contains all information that was previously entered during the creation of the item via

LogiKal.

2-D/3-D Metal Engineering
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2D

ﬂ Facade with 2-D sketch

=]

30

(¥ Importfrom ~ 3% Edi

B LR |
Project - ,;.1
Position Library Q
RS
a
A
&

== x|
T B eF F Ema- &
L= sie| T, | Modied |

<1KE MML-Dokument 131120120351
E2PKE MMLDokument 1371120120349

Qeskiog 31 KB XMLOokument 131120120320
Dratesodren
@ Dastesordner
Datesordner
My Computer
- File Mame: [HICAD log al£:pest K Load |
Hn:lk Fie Type: [30 Posiion import [xmi) =l Concel |
For the construction of drawings for

7.2.6

2-D/3-D Facade/Insert with Sketch

m  Option 2-D Facade/Insert with sketch

i J s

approval
connections, all HICAD functions are available. In addition, you can find
further, optimised tools for the processing of sections in the Metal Eng.
3-D Section function group of the Metal Engineering tab.

] |

containing wall

T Qi

Sealing Foil With
material

m Prior to this, a New 2-D part must have been created in the 2-D Part structure. The part

needs to be active.

= After this, use the 2-D sketching tools in
the 2-D Geometry tab to draw the outer
contour and the divisions (axes) of the
facade/the insert.

= On the Metal Engineering tab, choose LogiKal
2-D > Facade with 2-D sketch and select the
sketch. A LogiKal dialogue opens, enabling you

to select a beam/profile system.

istem and possibly applied rule packages as well as the subsystem
. ''ou are able to save a frequently used selection as a
might-click ta remove entries from favourites

Determing the position's profe
which narrows down the profile s
fawourite: which can be selected faster

2D-Part strcture

2t

2D-Part structure JEI RT3 Ui (1]

B 5 o

Conv... Facade Facade|

Ly

Sect. |

x|

Mew ME parts
LogiKal beams+ profiles

EE ‘Window/Door cross-section

Dl

_'}.i Facade with grid

[~ Perform Stiuctural Analysis for this Position

ID,D m

€ sharter side of building

Settings

Irstallation Height of Element:
The element is located at the

[

M Facade with 2-D sketch

[~

€ longer side of building
Distance of Element to Building Cormer:

Le.  [om m [Extemal isw]

Select 2-D sketch

*
| 150

Sustem Schiico FW 50+ v]

Schuco P B0+ —
Schiico AWS5/805 7551
Schiico A4S 57 RO
Alcoa 3572
Glazing bead variants an Alcoa 5070
during Input of Elements 341coa 5070-0UTS
Alooa 720 FF
4lo0a 720 HI PLFF
Add to Favourites| 4100 611

Alcoa 611 RS
Alooa 720

lons P20 FR =

500

1111
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m After this, LogiKal is launched

automatically and the = - e
beams/profiles will be placed on @ '
the sketch in LogiKal. e i 8

m The facade/window element can 8
then be configured with the usual g
LogiKal functions. — —

m Before performing the import to
HiCAD, LogiKal asks which views
/ sectional views should be
imported.

m Select the LogiKal function
Transfer drawing, which closes

LogiKal and imports the 2-D g8
element to HiCAD. You will be ' LB
asked to specify a fitting point
(left-click twice). 25 =
8
b o I OKEF(D) || 1} | 4
ilﬁ:mm i ——U A

When you choose this procedure, the facade/window element will only exist in HICAD, but not
in LogiKal.

m Use the Beams/profiles + facade -> LogiKal ;j ; 35
function to export the facade/window element to | com. rade facce| e
LogiKal. When you left-click the 2-D facade/window ook
element after selecting the function, an export file will

New ME parts
LogiKal beams+profiles

be created in the HICAD\temp directory. 1j wingouwoor ass-section
" o ) 13" Facade with grid
gikal-Export2 25.04.2012 13:31 ¥ML-Dokument KB
|| HICAD_logikal-Export2. xml.36. position.blb 25.04.2012 13:31 BLE-Datei 182 KB E Facade with 2.0 sketch
|| HICAD_logikal-Export2. xml.object.blb 25.04,2012 13:31 BLB-Datei 1KB
|| HICAD_logiKal-Export2. xml.position. blb 25.04,2012 13:31 BLB-Datei 182 KB gl Beams/profiles+facade —> LogiKal

m To perform the import, start LogiKal first. Use the LogiKal function Import from: File to
import the HiCAD_logiKal-Export2.xml file from the HICAD\temp directory. The xml
file contains all information that was previously entered during the creation of the item
via LogiKal.

13 Import from » ¢ Edi Y — o [ [T p———

Project

Position Library

Comcutm

ERE e

]
- #Wateiname ] G| Typ [ Getindern |
( |2 HICAD_lagik abE xport2. kml <1KB XML-Dokument 25.04.2012 1331
fassad E3TKB  xMLDokument 25.04.200121311
Desktop
=]
g

= LOGIKALGLASS xml <1KB XML-Dokument  23.04.2012 15:25
| HICAD _logik.al-E sport sl BKE  x¥ML-Dokument 12.04.2012 14:53
Archiv-1 Dateiordner

Archiv-15 D ateiordner
Abethl Logikal Dateiordner
e |
Eigene Dateien
Favoriten
Dateiname: =l fiffren
Dateitup: [30-Pasiionsimport [~ el =l Abbrechen |
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73

|

3D
7,

Sketch

32

Changes can be made at any time using the HICAD 2-D Geometry functions. However, such
changes will have no effect on the exported item in LogiKal. To keep changes in HICAD and
LogiKal up to date, the 2-D facade first needs to be deleted in HICAD and LogiKal, and the 2-D
creation sketch needs to be changed. Then, configure it via LogiKal again, using the Facade
with 2-D sketch function, import it to HICAD and, finally, re-export/import it to LogiKal.

Option 3-D Facade/insert with sketch

Create a sketch in a plane: Open the Sketch tab and select New - Create new
sketch in plane. A sketch will be created in the 3-D Part structure and the sketching

functions will be active. M_ »
17

3D-Part structure o x \
Rz 2 23 B

Use the sketching functions to draw the
outer contour and the divisions (axes) of the
facade/window element.

On the Metal Engineering tab, select
LogiKal 3-D - Facade/insert with sketch. |
In the LogiKal dialogue, choose a N

beam/profile system. | 20.part vucre EEENENN N
ﬁ L ay L )

x|

Determine the posiion's profile system anMmaggibly applied ule packages as well as the subsystem
which nanows down the profile selection, You STl to save o hequentl used selection as 2
=

favourite which can be selected faster. Llse right-click T Beam Glass  Insert Item. Grid §Sketch
[T Perform Structural Analysis for this Position Settings
Installation Height of Element: 0.0 m
The element is located at the: = shorter side of building
Distance of Element to Building Cormer. O e /
Left: 0.0 m (External Wiz
System Schiico P 50 v
Schico P B0+ -
Schuco AWS/ADS 75,51
Schiico AW 57 A0
&lcoa 3672
lazing riants ar [4lcos 5070
duting Input of Elements {Aicoa S070-0UTS
Alcoa 720 FF
|Alcoa 720 HI PLFF
Add to Favaurites| 105 511
lcoa 611 RS
Alcos 720
leoa 720 FR =
— L
A
After this, LogiKal is launched === = =
automatically and the |-
beams/profiles will be placed on -
the sketch in LogiKal. =
The facade/window element can - »
then be configured with the usual
LogiKal functions. — : 1

When performing the
HIiCAD will ask you to specify a -
fitting point on the part; if you =& “
right-click twice, the element will be
directly imported into the sketch.
Alternatively, you can left-click to select a
point on the element, and a succeeding

point in the drawing.

import, -
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in the drawing

If you select this procedure, the facade/window element will only be available in HICAD, but not
in LogiKal.

m The facade/window element can be exported to LogiKal with the
Beams/profiles+facade -> LogiKal function. For this to happen you need to select a
part of the facade/window element, or to the complete assembly selected in the 3-D
Part Structure (confirm by pressing the middle mouse button). After this, a
HiCAD_logiKal-Export.xml file will be created in the HICAD\temp directory.

Metal Engineering 3.D Dimensioning + Tex

G RRE ”ﬁﬁmé@”

Foil vith Uum Glass  Insert Rtm— W Sketch | U‘!Onw Edit.. Notch Exchang
!l! 1l

|_] HICAD_logial-Export.xml. 3.position.blb 13.11.2012 09:51 BLE-Datei 185KB

m To perform the import, start LogiKal first. Use the LogiKal function Import from: File to
import the HICAD_logiKal-Export.xml file from the HICAD\temp directory. The xml file
contains all information that was previously entered during the creation of the item via
LogiKal.

ﬁhpottl‘mm - ‘}‘\" Edi o i et o 1 e
| | e B e 2

:

B s o |

b -

PRIRapem e

& B cf B eter &

KB XMLDokument 13112012 0851
B27KB WMLDokument 131120120349
Doy = nl E91KE XMLDokument 131120120820
- | Avchivt Detesordner
g L Archoe2 Distemordrer
). Logkal Dateiordner
My Computer
= 0o I
Fie - |
. Type: [30-Pastion Impon [sm) = S
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= = Changes to the beams/profiles can be made at any time using the HiCAD 3-D Standard and
Steel Engineering functions. However, such changes will have no effect on the exported item
in LogiKal. To keep changes in HICAD and LogiKal up to date, the 3-D facade first needs to be
deleted in HICAD and LogiKal, and the creation sketch needs to be changed. Then, configure it
via LogiKal, using the Facade with sketch function, import it to HICAD and, finally, re-
export/import it to LogiKal.
Eﬁ m Use the Edit facade + inserts (3-D SE) function to Eg 7
E:jit change the element via LogiKal. You cannot 2L ﬁﬁ F_1
change the outer dimensions here, as these are | " fo EREIIE EREL | SE0E
pre-defined by the sketch. Glass thickness, inserts,
etc. can be conveniently changed via LogiKal.
7.2.7 2-D/3-D Facade/lnsert with Grid
20 = Option 2-D facade/insert with grid
- = When you select this option, a LogiKal dialogue will be opened, enabling you to select
E) the desired beam/profile system. LogiKal will be launched directly afterwards.
% = The facade/window element can be configured with .
B the usual LogiKal functions. o~ Fa_(;ge Fa‘éja S—e:t‘ |

X

Mew ME parts
LogiKal beams+ profiles

ri Window/Door cross-section

Determine the position's profile system S s s peckeges ss e 3 he cubsystem
which narows down the profle selection. ‘You are able (S T8Y ally used selection as @
favourite which can b selected faster. Use right-click ta remove entiies from P08

I= Perform Stiuctural dnalysis for this Pasition St
Istallation Height of Elemert:  [0L0 m
The element is [apated ot the € setersideof bl |\ Q&

€ longer side of building
Distarice of Element o Building Cormer

Left:  [o0 m (Extermal iew]

Swstem: Schiico Pw 50+ v‘
Sehica FW B =
Sehiico Aws /605 75,51
Schiico AW/ 67 RO
Elcos 3572
Blazing bazd variants anf " -2 2070
during Input of Elements {41503 5070-0UTS
lcoa T20FF
lcoa T20HI PLFF
Add to Eavourites| 41205 £11
tlcoa 611 RS
4lcos 720
lcoa 720 FR d

m  Before performing the import to
HIiCAD, LogiKal asks which views
| sectional views should be

imported. :
m Select the LogiKal function 71 17347
Transfer drawing, which closes
LogiKal and imports the 2-D ' i 8
element to HiCAD. You will be g~
asked to specify a fitting point g
(left-click twice). _ | i 25
g::;:m‘ I 110 2?';-;‘. (RELE
= i~ If you select this procedure, the facade/window element will only be available in HICAD, but not
in LogiKal.
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m  Use the Beams/profiles + facade -> LogiKal function

==
to export the 2-D facade/window element to LogiKal. L [ T

Conv... Facade Facade| Sect. |

When you select the 2-D facade/window element with a
left-click, an export file will be created in the Logikal beams+profiles
H|CAD\temp directory. EE ‘Window,/Door cross-section

Ui g Facade with grid
i | ?

a—s
ﬂ Facade with 2-D sketch

D New ME parts

XML-Dokument

B HICAD logikalExport2

25.04.2012 13:31

|| HICAD_logiKal-Export2.xml.88.position.blb 25.04.2012 13:31 BLB-Datei 182KB —

% Beams/profiles+facade —+ LogiKal
|| HICAD_logiKal-Export2. xml.object.blb 25.04.2012 13:31 BLB-Datei 1KB L
|| HICAD_logiKal-Export2.xml.position.blb 25.04.2012 13:31 BLB-Datei 182KB

m To perform the import, start LogiKal first. Use the LogiKal function Insert from file to
import the HiICAD_logiKal-Export2.xml file from the HICAD\temp directory. The xml
file contains all information that was previously entered during the creation of the item
via LogiKal.

| [ET— p———

_‘1 Import from » - Edi EE E
Project
Position Library

Element Template

i

araaazsese

L]

=l = @& ef B Eorr

= D areiname ] Grosse| T | Gebndet I
j'|l < *| HICAD_logek.sHE xport2 el CTEE  MML-Dokument 2504221331
e fass: EI1KE XMLDokument 250420121311
iestig *| LOGIKALGLASS wml ¢1KE XMLDokument 23.0420121525
; * | HICAD_logik aHE wport sl BKE XMLDokument 120420121453
@ Archiv-1 Dstesonchront
. Hrchi15 D oo chros
Arbeitzplatz Logial D stesonddrist
Exgene Datesen
~
*
Favoriten
Oseosne  [EADEIETE T
Dateiyn [30 Posionserpont [z 7] _fbechen |

Changes can be made at any time using the HICAD 2-D Geometry functions. However, such
changes will have no effect on the exported item in LogiKal. To keep changes in HICAD and
LogiKal up to date, the 2-D facade first needs to be deleted in HICAD and LogiKal, and the 2-D
creation sketch needs to be changed. Then, configure it via LogiKal again, using the “Facade
with 2-D sketch” function, import it to HICAD and, finally, re-export/import it to LogiKal.

m  Option 3-D Facade + insert with grid

Before importing the element, you need to define a processing plane, into which the
window/facade element will then be imported. This will prevent a subsequent rotating or moving
of the part. The import is performed according to the active coordinate system. If no processing
plane is active, the element will be imported according to the World Coordinate System.

LogiKal elements are aligned as follows: The X-axis always refers to the width of the elements,
the Y-axis to their height and the Z-axis to their depth!

To access the function, select Metal Engineering = LogiKal 3-D - Insert facade + insert
with grid. A LogiKal dialogue opens, enabling you to select the desired beam/profile system.
LogiKal will be launched directly afterwards.

2-D/3-D Metal Engineering
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x|
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= You configure the facade/window element with the usual LogiKal functions.

When importing the element that was configured in
LogiKal, you will be asked to specify a fitting point on the
part. You can then directly determine the correct position
for the insertion in the HICAD drawing by left-clicking
twice.

Alternatively you can right-click twice to place the
element in the origin of the processing plane.

. If you select this procedure, the facade/window element
will only be available in HICAD, but not in LogiKal.

% m The facade/window element can be exported to LogiKal with the
L Beams/profiles+facade -> LogiKal function. For this to happen you need to select a
part of the facade/window element, or to the complete assembly selected in the 3-D
Part Structure (confirm by pressing the middle mouse button). After this, a
HiCAD_logiKal-Export.xml file will be created in the HICAD\temp directory.

Export

Metal Engineering 3-D Dimensioning » Text Sketch

7 ﬁ%ﬁg%

ltlm Glass  Insert Irm. Gdd Sketch Chingr Edit... Hotch Excl

|__| HICAD logiKal-Export.xml. 3.position.bib 13.11.201209:51 BLE-Datei 185K8

m To perform the import, start LogiKal first. Use the LogiKal function Import from: File to
import the HICAD_logiKal-Export.xml file from the HICAD\temp directory. The xml file
contains all information that was previously entered during the creation of the item via
LogiKal.
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i sl B3 KB WML-Dokument 1311.201209:20
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My Computer | |
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—i File Type: " .
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Changes to the beams/profiles can be made at any time using the HICAD 3-D Standard and
Steel Engineering functions. However, such changes will have no effect on the item in LogiKal.
To keep changes in HICAD and LogiKal up to date, the 3-D facade needs to be deleted in
LogiKal. In HICAD, the item then needs to be edited via LogiKal with the function Edit facade +

2

inserts (3-D SE). =
i

All parameters (dimensions, glass etc.) can be P’fb?'
changed. The facade/window element changed in | c...-0Edit.. [Motch Exchange Export
LogiKal replaces the element existing in HICAD. -

i

Settings

Caution: If you select this procedure, the changed facade/window element will only be available
in HICAD, but not in LogiKal. If you want the element to be available in LogiKal as well, you
need to re-export/import it to LogiKal.

7.2.8 2-D Section of a 3-D LogiKal Facade

This option is available via Metal Engineering - LogiKal 3-D > ﬁ
Beam - 2-D section of 3-D facade. L

W i 7

Beam | Glass Insert Item. Grid

New ME parts
LogiKal insert+facade

For this option a 3-D LogiKal item needs to be available in HICAD. It

must have been created with the following options: if y dmduatbeam/prorle
m Insert 3-D facade + inserts from existing LogiKal project sEE pindoa/Doogprciile
m 3-Dfacadel/insert with sketch gi‘?. 2.D section of 3.D facade

m 3-Dfacade/insert with grid

2-D/3-D Metal Engineering
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When you choose the 2-D section from
3-D facade function and select the 3-D
LogiKal item in HiCAD, LogiKal will be
launched, displaying the sectional view of
the drawing.

17547

Now specify the 2-D views/sectional

views that should be exported to HICAD. - -

13 -
Select the LogiKal function Transfer T
drawing, which closes LogiKal and - &
imports the 2-D views to the desired ... | N —|—NY =
positions in HICAD. You will be asked to  7eee | -

specify a fitting point (left-click twice).

7.2.9 Change Glass in Insert

To access this function, select Metal Engineering = Process, LogiKal 3-D = Change glass
in insert.

To be able to use this function, a glazing construction must have been created from single
beams/profiles or via the HICAD grid.

For this, the glass insertion points 14 and 24 are mandatory (see Chapter 6.1.6 Glass Insertion
Points). These points will be automatically and invisibly supplied in the following cases:

m If a facade construction is created from individual beams/profiles as described in
Chapter 7.2.1 3-D Import of Individual Beam/Profile Cross-Section, these points will
be automatically supplied.

m If a facade construction is created via the HiCAD grid option, as described in the
Chapter 6.2.4 Facade via Metal Engineering Grid (Metal Engineering Plugin), these
points will be automatically supplied. If you use your own series beams/profiles, these
points need to be created manually. In case of a use via LogiKal these points will be
automatically supplied.

Before executing the Change glass in insert function, you need to define a processing plane.

LogiKal elements are aligned as follows: The X-axis always refers to the width of the elements,
the Y-axis to their height and the Z-axis to their depth!

Then select the HICAD glass with a mouse-click. A LogiKal dialogue will be displayed, enabling
you to choose the desired beam/profile system for the insert. LogiKal will be launched directly
afterwards, so that you can configure the insert with the usual LogiKal options.

After finishing the procedure, the glass will be deleted automatically, and the LogiKal insert will
be created in the plane of the glass.
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[ e 5%

Change § Edit... MNotch Exchange Export

p— —
(z) s 1
by H A
Change Contour Exakt
part type

Settings

reate Hew Position x|

Dictermine the position's profile system and passibly applied rule packages as well s the subsystem
which narraws down the profils selection. You are abls to savs a hequently used selsction as a
favaurite which ean be selected faster, Use right-click to remave enties from favourites.

I | Peiform Stictural Analysis for this Position Seltings
Iristallation Height of Elerment: 0.0 m

The elerment s located at the: € shorter side of building
 longer side of building

g o of Element b Building Correr:

Left 0.0 m ([Extemal View)

Schiico w50+ ]
SThles P BOv =
Schiico AW DS T5.51
Schiico WS 57 RO
Elcos 72
Glazing bead variarts anf =22 5070
during Input of Elements {Alcoa S070-0UTS
4lcos 720 FF
lcos 720 HI PL FF
Add to Eavourites| 4/c0q 611

lcos B11 RS
lcoa 720

Icoa 20 FR d

System

Caution: If you select this procedure, the changed facade/window element will only be available
in HICAD, but not in LogiKal. If you want the element to be available in LogiKal as well, you
need to export/import it to LogiKal. See also Chapter 7.2.10 Export Facade/Insert to LogiKal.

7.2.10 Import Facade/lnsert to LogiKal (3-D)

m The facade/window element can be exported to LogiKal with the %
Beams/profiles+facade -> LogiKal function. For this to happen you need to select a L
part of the facade/window element, or to the complete assembly selected in the 3-D Expart

Part Structure (confirm by pressing the middle mouse button). After this, a
HiCAD_logiKal-Export.xml file will be created in the HICAD\temp directory.

CI——— e | B R OH

| Change Edit... Settings  Change Contour Exakt |
[ part type |

&
;
)
=
g
@
L

|| HICAD _logikal-Export. sml. 3.position. bib 25.04.2012 15:59 BLB-Datei 181KB
|| BNBQSXDHEQETYD 1. KRPFEAARCHIVE 25.04.2012 15:56 KRPFEAARCHIVE-D... 1KB
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To perform the import, start LogiKal first. Use the LogiKal function Import from: File to
import the HICAD_logiKal-Export.xml file from the HICAD\temp directory. The xml file
contains all information that was previously entered during the creation of the item via
LogiKal.

¥

= Import from = - Edi

[ TS - p———— |

Project
Paosition Library
Element Template

= x|
s 3Bk B e &
5 =" Siza| T, | Modied |
L ! I <1 KB ¥ML-Dokument 131120120351
Dk = LogiMLEsssadeSKZ B2T KB XML-Dokument 1311.20120%49
i = logeanlfimpoet2 sl 691 KB HML-Dokument 1311.20120320
Archiv Datesondner
&j! Archiv-2 Datesordner
. Logial Dratesordrier
My Computer g
File: Hame: - sH I
i H. [HICAD _logi-abE xport = Load
3 File Type: [30-Postiorrimpat (-] = Concel_|
M Docsmante |

gaaaspp s

The LogiKal 3-D export can be used for the following options:

e 7.21 3-Dimport of individual beam/profile cross-sections

e 7.25 3-Dimport of existing LogiKal items

e 7.26 3-Dfacade/insert with sketch

e 7.2.7 3-Dfacade/insert with grid

e 7.2.12 Facade via Metal Engineering grid (Metal Eng. Plugin)

7.2.11 Edit Facade/lnsert via LogiKal (3-D)

o Use the Edit facade + inserts (3-D SE) function to —_—r = -
ﬁ change the element (dimensions, glass, etc.) via e ﬁ E 5‘3% ﬁ ﬁ‘_’l

LogiKal. It will be directly updated in HICAD.

Change Motch Exchange Export  Settings

-

. Caution: If you select this procedure, the changed facade/window element will only be available

N in HICAD, but not in LogiKal. If you want the element to be available in LogiKal as well, you
need to delete the item in LogiKal, re-export the HICAD item, and import it to LogiKal. See also
Chapter 7.2.10 Export Facade/Insert to LogiKal.

i

Edit facade + insert via LogiKal can be used for the following options:

e 7.25 3-Dimport of existing LogiKal items
e 7.2.6 3-D facade/insert with sketch
e 7.2.7 3-D facade/insert with grid
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7.2.12 Place Beams/Profiles on Grid via LogiKal

In this chapter, beams and profiles are placed on a Metal Engineering grid (Metal Construction
plugin) via LogiKal. Prior to this, the steps described in Chapter 8 Facade via Metal
Engineering Grid (Metal Construction Plugin) need to be performed.

Metal Construction *
Base type: | Example Polygon Facade -|
Configuration: [

- Base parametars

Number of segments:
Height: 1000 -
Start angle

Active surface:

Base edges Angle (X¥-plane. Inclination

1 2000 o 120 00

2 2000 1 120 10

3 2000 2 120 2 0

4 2000 3 120 30

[ Equate | [ Equate | [ Equate |
~ Mullion . - Transom .
Quantity: Quantity:
o []o & []o

i [] 2000 i [] 1000

o [Jo & [Jo

o AN ¥ Uniform transom distribution for all sur

lCut with plane (3 pnin'ts| |l’m-rrl r-.=|

- Calulaton options
Preview, automatic :: l;::tlf :i EI:b:iL

.
Mullion, vertical L o N e |

~ (5]

i~ Further..

|| show dimensionings

I New | [ Save | [ Save, new

[ Apply | [ Cancel

Engineering = Grid =2 Assy. = Grid connections, via LogiKal.

6. Mullion/Transom notching # 90° (Schifter notch): Via HICAD Design
Variant. Metal Engineering =2 Grid = Assy. = Grid connections,

Via HiCAD Design Variant.

7. Glass insertion can be performed automatically and across the

5.

The creation of the grid is described in Chapter
8 Facade via Metal Engineering Grid (Metal
Construction Plugin). Please perform the
steps in this chapter beforehand.

On the Metal Engineering tab, select Grid 2>
Mullion or Transom via LogiKal to place the
beams/profiles on the sketches. You can also
use “collection” functions for the selection of
equally aligned axes:

- CTRL + left-click = Collection/deselection
of individual (sketch) axes

- SHIFT + left-click = Automatic collection of
equally aligned (sketch) axes

%3 %j@[ﬂﬂﬁ :

Assy. Mulliorfl Mullion flransomiTransom,

Right-click to open a LogiKal dialogue enabling
you to configure the desired mullions/transoms.
Bent mullions are automatically recognised and
the hip angles will be initialised with a
corresponding value in the = =
LogiKal dialogue. Otg % #

| Assy. | Mullion Mullic

The beams/profiles will be

automatically placed on the o Meral Eno- one

o
I Grid assembly

sketches. .

B % Templates
Mullion/Transom notching = | giass
90°: Via LogiKal. Metal

m HiCAD glass
.‘m LogiKal glass
1

Grid connections

M Via HICAD Desig

% Via LogiKal
] 1

complete facade via automatically via Metal Engineering 2 Grid 2>

Assy. 2 HICAD glass or LogiKal glass.

8. Here it is important that you define a suitable glass pane, or select a
glass pane with the glass thickness that was previously specified in

the LogiKal dialogue.

Use the grid connection via LogiKal for mullion/transom notchings = 90°, and
the grid connection via HICAD Design Variant for mullion/transom notchings

# 90° (Schifter notch).

2-D/3-D Metal Engineering
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| Assy. | Mullion Mullion

Metal Eng. grid
Grid assembly

| = Templates

Glass

m HICAD glass
.‘m LogiKal glass
1

]
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8 Facade via Metal Engineering Grid (Metal
Construction Plugin)

This chapter describes the creation of facades with the help of the Metal Engineering grid
(Metal Construction plugin).

For a convenient working with the 3-D planning grid, Metal Engineering grid templates are
provided in the Metal Construction plugin.

You activate the Metal Construction plugin via Settings > Plugins.

Hitor HELIOS FDM
Settings
Qj’ Colour settings 4
v

Activate Start Centre

Activate space mouse

Qf GUIrepresentation »

[ touste |[ vguste  |[ Eowme |
Mullion Transom Ribbon categaories

Guantits (2~ | Quansmn [~

¢ o = (= 1Te Metal Construction |_4f
|l 2000 = IJ 1000 B
how demencons

(E— oo —| "] oy

ooy [ ] |

-

Plugins

Toalbars

Docking windows

The Metal Construction plugin enables the configuration of individual facade contours via the
Grid functionality with only a few mouse clicks, and assign mullions, transoms and glass panes

to them.

For this purpose you can choose between the twoO  Fie Edit View Extras Helios Settings ?

templates “Ridge roof’ and “Polygon facade” (saved in = =
the HICAD Catalogue) from the Base type selection box | & 3 i |
at the top of the plugin window. =@ Catalogues -
- A ducts
The sample templates in the Catalogue Editor can be "@ Beanngs
accessed via Catalogues - Factory standards > "@ Cylinder
Grid. E@ Factory standards
@ User material
@ Sernies

In the Configuration selection field you can enter the
names for the specific sample facades you created.
These can then be saved to the catalogue and reloaded

@ Glass panes
@ Sheets

@ Macros

atany time. @ Multi-part standard beams
. . -
At the bottom of the plugin window you can apply or . .
. . @ Metal Engineering Connections |_|
save changes, create a new conflguratlon, or save an
@ Bore patterns

existing configuration with a different name by clicking
the corresponding buttons.

K.

Use the Select sketch button to apply the facade
contour of a sketch drawn in the top view. Click the [Metal Construction X
button, then identify the sketch and, after generation | Base type: | Example Polygon Facad
of the fgcade,_change the_dimension parameters in Configuration: | p- ﬂ
the plugin navigator if required.

-~ Base parameters

Mumber of segments: |4 vl |
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Metal Construction X 1. In the Base parameters area,
Base type: | Example Polygon Facade - | enter the _Number Qf segments
_ and the Height. A grid consisting
Configuration: | il |@ of connected sketches in the
desired form will then be available
~ Base parameters to you.

Mumber of segments: |"r b |

Height: 1000 -] 2. ﬁfae/lv};ngthe sketches to your
Start angle

3. If required, modify the sketches
Active surface: | Surface 1 ,| with the usm_JaI st_andard functions,
e.g. to obtain oblique transoms.

Base edges Angle (X¥-plane] Inclination . .
d gle (X¥-plane 4. Select Grid - Grid assembly,
1 2000 0 120 o0 new Create the predefined
% iggg é ﬁg ; g assembly  structure. In the
4 2000 3 170 " structure browser, move the grid
assembly into the “Planning grid”
[ Equate | [ Equate | [ Equate | assembly.
_ Mullh" R ’_Transﬂm ) E]TF/ 4)Position I{ASSEmhly} 'i}
@anning grid {As@
Quantity: Quantity: =-*45 i) Assembly {assembly}
i ) Surface 100
o []o = []o P
- . il surface 2 O O
1 D 2000 1 D 1000 f'—f'— i Mullion {Assembly} O
o []o ¢« o || | L. == i) Transom {Assembly}
----- ﬁf i) Glass elements {Assembly} £
[ i Inserts {Assembly}
Uniform transom distribution for all sun 5. Activate the Planning grid

assembly.

[Cut with plane (3 puints| |r=un-p| cut

6. Use the Mullion or Transom
. : from catalogue function to place
Close contour ~ Calculation options —— .
Prmew p— | € Local (& Global trlm(et hbe(’;ams/proflles onto the
. (% Start fix O End fixe sketch edges.
Mullicn, vertical

~ Further..
|| Show dimensionings
[ New | [ Save | [ Save, new |
[ Apply | [ Cancel |
The placing of beams/profiles on grids is described in the following chapters: = .~

- 6.2.4 Insertion on Grid via User-Defined Beam/Profile Cross-Sections

- 7.2.12 Place Beams/Profiles on Grid via LogiKal
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9 Representation Options

9.1.1 Tangential Edges/Lines

m Tangential edges can be switched off as follows: Right-click the view frame (pink
dotted rectangle) and select Properties - Show/Hide edges in view.

SIS SIS v

LSS AT

,.f&,//
@;ﬂ;’

Select Settings / Basic settings / 3-D / View / Visualisation / Hide tangential edges: Yes in
you want tangential edges to be hidden in new views by default.

m To hide the edges behind the glass, you need to change the transparency of the glass
in the sectional view. To do this, right-click and select Properties > Properties in
view, Transparency - Not transparent.

£ :

9.1.2 View-Dependent/Part-Dependent Control of Representation Type

In all of the previous examples, the EXACT representation was used for the insertion of
beam/profile groups. In some cases, however, a SIMPLE representation of the beam/profile
groups would be preferable:

= In overall views, very many single edges would be rather confusing. A simplified contour
would be sufficient.

= Important points might not be available for identification (e.g. beam/profile corners when
there are radii, top/bottom edges of glass insertion surfaces etc.).
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Therefore, HICAD offers the following three representation types:

Representation type

Description

Examples of use cases

EXACT representation

m All individual beams and
profiles of a beam/profile
group are displayed

m Each individual beam/profile
is displayed as exactly as
possible

m This is the default setting for
newly inserted beam/profile
groups

m Cut beams/profiles in 1:1
sectional views

m Representation in enlarged
detail views (perspective views,
shaded details etc.)

m Checks of 3-D design drafts

CONTOUR
representation

m Only one CONTOUR part is
displayed for the complete
beam/profile group

m The individual elements of the
beam/profile group are hidden
via list view functions

m A view- and part-dependent
switching between CONTOUR
and EXACT representation is
possible

m Beam/profile representation in

overall views

m For an easier identification in

design drafts

SIMPLE representation

= All individual beams and
profiles of a beam/profile
group are displayed

m Each individual beam/profile is
displayed with a simplified
geometry

m By default, the generation of
simplified geometries is
deactivated in the LogiKal
interface configuration

m A part-dependent switching
between EXACT and SIMPLE
is possible

m The parts are displayed in all
views of a drawing either
exact or simplified

m Performance enhancements for

large drawings during the
design draft phase

2-D/3-D Metal Engineering
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9.1.3

Switching Between Exact and Contour Representation

Functions for a view-dependent, direct switching between EXACT geometry and CONTOUR
representation are available, so that you do not need to use the general Hide/Show functions

for this.

9.14

You can access these functions as follows:

In the Process, —_ New view
LogiKal 3-D M B SeSs800 3
function group of TS — Others »
the Metal Edit
Engineering tab. GDHEGES S

=

Others b
Open the context menu for views

(right-click pink dotted view
frame) and select Others - ME
assembly.

Sr.’ 3=I. J_El

P : ’E Exact representation

Others 4
Representation
ﬂ]@..'...-;" p
o Bo
Others »
- Properties
2 Show/ Hide parts
— Show
8 ol e
E ¥ Hidden edges
5 Othars 3 S
= ['% Highlighted edges
2 Delete =
2 P Shadin e
§ Delete active view (3-D) ‘ ShE
= ME assembly
Properties .
E 74  Contour representation

Hide Seals and Rubber Parts

Seals and rubber parts can be hidden and redisplayed during designing.

|Change| Edit... Motch Exchange Export | Settings

On the Metal Engineering tab, select Process, LogiKal 3-D - Change -> Hide
seals.

A LA AN

Process part Process, LogikKal 3-D

4% Fitting offset

& 7 Change glass
mM ge g
SR

m Add via LogiKal

.
ﬁ\? Hide seals

.
ﬁ'ﬁz: Show seals
"5
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9.1.5 View-Dependent Hiding/Showing of Axes and Tangential Edges

In drawing views you often want profile axes, tangential edges of beam/profile radii etc. to be
invisible, i.e. hidden. However, their visualisation is rather useful during designing in 3-D.

To hide or show edges in views, use the Hide/Show edges in view function in the context
menu for views.

E Properiies I
L= - r

] D

Other Show/Hide edges in view

9.1.6 Show Facade Sections from Detail Views + Show Dimensions/Texts

The creation of complete sections through facades was formerly achieved via the creation of
large-scale sectional views and the shorting of views.

If further functionalities for sectional views are required, e.g. drawing- or sheet area-
comprehensive, associative dimensioning, the following procedure can be used:

Create an unshortened sectional view with any scale
Add annotations and dimensionings in the unshortened sectional view

= Create detail views for the visible areas of the complete section, and arrange the detail
views in the drawing(s)

= Show all dimensions and annotations of the unshortened sectional view in the detail views
(open the Views tab and select View Functions - Show - Show 3-D dimension/text).
In the active detail view, all 3-D dimensions and part annotations of the reference view that
lie within the detail will be shown/updated

Metal Engineering 3-D Dimensioning+Text Sketch

(2 U & G G &

| Show | Hide HideAll HideHL Freeze FreezeAll FreezeHL || Update CutOut CutOut Section Detail Shor

- - -

View
Show
=
D@ All+=Update
- A
Others
==
Link views
L] ]
Dﬂ Eearrange
P
L9 |
-E‘ﬂ Arrange view group
10
-l Show 3-D dimension/text
ol =]
Select

Show/Update 3-D dimensions + texts in detail views

F%J Via list
fal=I]
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10 Glass Functions
10.1.1 Glass Insertion Dialogue and Settings

To expand the list of glass types, open the Catalogue Editor and go to Materials - Glass >
Glass types.

For example, if you copy Row 7 with the ID 13 and paste it at the bottom, you have the option to
select a coating side for this glass pane in the “Coating” column.

[ifk| CATEditor - | Glass types

File Edit View Extras Helios Settings 7

T SAPbkEsoces BB & 2

= @ Catalogues D | MDDl STATUS | BZ ‘ COATING ‘ COATING_BZ ‘ RHO ‘ SRAF ‘ MATERIAL | D | COLOR. ‘ COLK ‘
m @ Air ducts |4 35 » Contraflam 30N2 O 2.5 40 Contraflam 30N2 16 -1 -1
@@ Bearings 2 3% » Contrafiam 60N2 ] 2.5 40 Contraflam 60N2 24 -1 -1
(-4 Cyinder Z 11 » ESG 10 ] 2.5 40 ESG 10 10 -1 -1
-4 Factory standards |4 12 » ESG 12 O 2.5 40 ESG 12 12 -1 -1
-4 Fasteners 5 7 » ESG 3 O 2.5 40 ESG 3 3 -1 -1
=@ Metericls | sl 13 » ESG 4 ] 25 20 E564 4 -1 -1
@ stecl e 3 b EGS (=] 2.5 40 E5G 5 5 1 1

@ Castiron | 3 3 » ESG5 O 2.5 40 ESG 6 5 -1 1

: ;ﬁ:!::' | sl 10 » ESGE O 2.5 40 ESG 8 E -1 -1

10 5 » Float 10 ] 2.5 40 Float 10 10 -1 -1

z 6 » Float 12 O 2.5 40 Float 12 12 -1 -1

| 12| 14 » Float 4 ] 2.5 40 Float 4 4 -1 -1

| 13| 2 » Float 5 =} 2.5 40 Float 5 5 -1 -1

Stone types 14 3 » Float & = 25 40 Float & 6 -1 -1

@ Aopendix 1o = L Slaal = L2 <L eal ” .
@ Piant Enginesring I 15| 112200045 = ) Float 8 P = 2.5 40 Float 8 F 3 -1 -1
[#-§@® Processings, general | 17| 1 X Glass = 25 40 Glass [} -1 -1
0 Semi-finished products | 18] 32 » Pyrostop 30- O 2.5 40 Pyrostop 30-10 15 -1 -1

| 16| 112200045 = » FloatdP 2.5 40 Float 8P g -1 -1

In the glass insertion dialogue the coating side will be evaluated as follows:

Glas Aufban il = E5G 6: 6/15/6/15/6. x|

Beschichtung: HBE
B1 )@ Glasscheiben BZ D
AuBenscheibe ESG 4 beschichtet i II:I vl sy P ESG4:4/8/ 16

f = Kommentare b s s
Al IB j B1 |12 j A1I b ESG6:6/1527

P ESG6:6/15 43

[#] Innenscheibe |E5G4 j II:I j P vSGEL &5

b USGE-2 65

I0 j I‘J j AZI P VSGE-2: 7/ 6.5
b VSGE-2: 7/ 47
[7] 3. scheibe | | | -] |

|B2]
Gesamt-Glasdicke, mm 16 [ Sollwert: 30
Bezeichnung  [ESG 4: 4/3/4 =l
AN
Kommentar I j

jv
[7] Fenster nicht mehr anzeigen QK 0[ S — ] Abbred"len] (o ) [ avbeden ) A

A N

The coating will be considered for itergisation and identical part search, i.e. the workshop
drawings of the glass panes will always be\greated from the exterior view.

The glass structure needs to be given a Designation and saved to the HiCAD catalogue.
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The glass cross can be hidden/shown via the following files:

- HiCAD/sys ... stb_parameter.dat > Line 90 (Display glass ID)

aisp]ay glass id (cross in the glass centre of gravity) (0 = no, 1 = yes) : - Glaskennung darstellen (Kreuz im Glasschwerpunkt) (0 = nein, 1 = ja) :
il

- HiCAD/sys ... stb_parameter.dat > Line 199 (Position of glass ID)

position of glass id (0 = centre, 1 = outside, -1 = inside, 2 = inside and outside) : - Position der Glaskennung

10.1.2 Glass Insertion in 3-D

HiCAD offers a function for the 3-D insertion of glass panes in mullion-transom constructions.

The glass structures are managed in catalogues. Further, customer-specific catalogues, tables .
and glass panes can be added at any time. Glas
The Insert glass function can be found in the Metal -
Engineering, 3-D function group. A

Teileart ‘Glas Skizze Werl..

- -

il

When you click on a glass field, the glass dimensions will be automatically calculated on the
basis of the limiting profiles, by taking the glass insets (see also 6.1.6 Glass Insertion Points) of
each limiting profile into account.

wid

After selecting the function, you can also right-click first, and then left-click to “collect” the
profiles forming the frame.

After selection of the glass field (left-click a point on the glass field; if required: right-click to
select individual profiles) you need to define the glass structure by specifying the individual
glass panes, the gap width and the edge compound width.
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10.1.3 Automatic Glass Insertion — Directly Connect Beam/Profile End Points

When a 3-D glass insertion is performed, the axes of the limiting beams/profiles will be
‘ij lengthened to an intersection point to enable the calculation of the glass sketch. This means
that a glass insertion is even possible if the beam/profile axes do not directly intersect.

However, if no intersection points of the beam/Profile axes can be calculated, a glass insertion
via the standard option will not be possible. Such cases can occur, for example, if no limiting
profile exists for one or several sides of a glass.

To still enable an automatic insertion (i.e. without having to define a sketch manually), you can
use the Steel Engineering function for the handling of end points:

Open the Steel Engineering tab and select Further functions - Settings = Glass insertion

- End points.
& > £y i s
F A AR
Einstellungen fiir Glasei x| rim... Begr.. Exras | |Einst.||| Kopieren Akt. Losch..
inktionen Verwaltung
1 all instellungen
(@) Bis Schnittpunkt verlangern Gmndty'u.. E_] —
(7 Direkt verbinden o Ll
- Glaseinbau | Glaseinbau 3
Einstellungen
rDKJ [ Abbrechen } uj ERARTE %Pmmtexﬂ

=4 ﬁ Textkonfigurationen
Lj Defaultglas
— _

10.1.4 Hidden Line Representation, View-Dependent Glass Pane Transparency

Normally, all parts located on Layer 40 will be transparent. This is the default setting for glass
panes, i.e these will be displayed correctly in shaded views.

However, since no Hidden Line calculation is performed for transparent parts, a transparent
representation in sectional views would cause problems.

Therefore, use the function Properties = Properties in view, Transparency to
activate/deactivate the transparency for each view, independent of Layer 40.

10.1.5 Stepped Glass

’ 7 The creation of stepped glass is performed with the function
=2 Metal Engineering - Metal Engineering, 3-D >
Verl.., Lengthen.... To lengthen a glass, select it at its edge and

lengthen it via value entry or via the picking of points.

= ,
o
Teileart Glas Shizz

-

Alternatively via right-click on glass pane:

Select Sheet Processing: Lengthen in sheet
direction (value), or Lengthen in sheet direction, 2
points.

4

hnbauen (3D

\Verlangern in Blechrichtung 2 Punktel
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11 Create Wall Connections (3-D)

B 3-D sectional views for detail planning

The tools for detail planning can be found at Metal Engineering = Metal Eng., 3-D Section.
These functions can gnly be used in sectional and detail views. You work in the same way
as in 2-D drawings while using the benefits of 3-D design at the same time. The parameters

for annotations are automatically entered in the part attributes.

The tools for detail planning can only be used in sectional and detail views. For previously
created sketches, please make sure that the processing plane actually lies in the sectional view!

b I

Versieg... Folie

"

Werkstoff

the picking of two edges. The
edges do not need to run
parallel.

previously creates sketch.
Use the “Foil” option to
identify the sketch, and then
change the desired foil
parameters.

During insertion you will be
asked to specify the direction
of the foil thickness.

51 o] ﬂ
- Einbau = a
= i -  Teil aus Linienzug
Durchlassigket Ausfiihrung SRS D e
I Durchlsssigkeit  Teil dber Kontursuche
Material Ayl - Liicken schiiefien
mit Dichtschnur Bemerkung \:\ Toleranz: =
Stiicklistenrelevant -
WIS ~ Attribute
~ Einstellungen
~ Dichtschnur =
i - V] Aus Katalog
I @
Hahe Hi=1.5Breite Kehlradius || Transparent
[ Eingabe [] stiickiistza
r Mit Profilachse
e _
Mit Achsenendpunkten
~Filllung ————————————
. LI
s 1] o ][ swbremren | | 2
Hehe H2=Breite wenn Breite /—| D [
Keiner als 1 cm und —
H2=0.5*Breite wenn Breite -
grofier als Iom = m Teilearten 20
["|Eingabe [ Metallbau f Fassadenbau
H2: |
[ [ | [ Abbrechen |
BZ
+  Belag, Erde Erzeugt 2D-T|
+  Beton bewehrt Erzeugt 20-T|
+  Beton unbewehr Erzeugt 2D-T
+Fiillstoff Erzeugt 20-T
Holz massiv Erzeugt 20-
+ Isolation hart Erzeugt Z%
Material
The insertion takes place via | The insertion requires a | Several insertion options are

possible (see screenshot on
next page).

Select the desired part types
via the catalogue.
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1%

Fitting mode:

Einbaumodus
(" Teil aus Rechteck

(% Teil aus Linienzug
(" Teil aus aktiver Skize
(" Teil iiber Kontursuche

- Part from rectangle > Create a rectangle from two
diagonally opposite points in the sectional/detail view.
After this, HICAD automatically generates a solid body
in positive and negative Z-direction. After updating the
sectional/detail views the correct hatchings will be
displayed.

Liicken schiiefen

Toleranz:

- Part from polyline > Draw a polyline in the sectional/detail view. Please make sure that the
polyline is closed, i.e. does not have any gaps. After this, HICAD automatically generates a
solid body in positive and negative Z-direction. After updating the sectional/detail views the
correct hatchings will be displayed.

- Part from active sketch - Draw a sketch (closed polyline) in the sectional/detail view.
Please make sure that the polyline is closed, i.e. does not have any gaps. After this, HICAD
automatically generates a solid body in positive and negative Z-direction. After updating the
sectional/detail views the correct hatchings will be displayed.

- Part via contour search > This option is normally used for the part type “Insulation
soft/hard”. Click the desired area of a sectional/detail view. HICAD auto-generates a sketch with
the boundary edges and creates a solid body in positive and negative Z-direction. You can
specify a tolerance to directly close gaps that are smaller than the entered value. After updating
the sectional/detail views the correct hatchings will be displayed.
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12 HiCAD Design Variants for Metal Engineering

12.1 HiCAD Mullion-Transom Notching

Connection via grid

Individual insertion

Metal Engineering = Grid = Assy. = Via

HiCAD Design Variant

- see also Chapter 7.212
Beams/Profiles on Grid via LogiKal

%3 fu 1= 4

|Baugr...| Pfosten Pfosten Ri

| Metallbauraster

H

‘| Raster-Baugruppe
[

! = Vaorlagen

Glas

& Hicad-Glas
m' Logikal-Glas

Raster-An

: Uber Hicad DV

Place

‘Civil Engineering functions’ docking
window - Metal Engineering/Facade
Engineering = 3-D Metal Engineering 2

Metal Engineering beam/profile
connections

- see also Chapter 7.2.1 3-D
Individual
LogiKal

[l

Import of

Beam/Profile Cross-Sections via

#- Stahlbau
= Bauwesen allgemein
- Bauwesen - Teileartkatalog
70| 3D

wm
% Metallban | Fassadenbau
= 3D Metallbau
== M -An: u:
B Anschluss Schiico FWS0+/FW60

apfay 3 ajanstsy,

UBLorUSUoy| l

—“-—_‘-————'—/—
Groe: ——— ———(GroBe Symhole)

OISy (12

LBLOIHUN J-LaSahnes
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vl
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73

For the HICAD Design Variant you normally use the glass insertion points (Chapter 6.1.6 Glass
Insertion Points) and the additional Points 15 and 25. The Type of use of the mullion and

transom needs to be set to Support profile.

Assigning of the Type of use:

In the Part attributes window (double-click beam/profile, or right-click beam/profile and then
select “Part attributes”), enter Support profile for Type of use.

ervendungsart |Trag profil

—5t

The definition of the glass insertion points and the 15 and 25 takes place via the creation of

isolated points with corresponding point numbers.

The point numbers are defined as follows:

Point s10 and 20 define the glass inset > The points must be located in the 2-D part

GLASS

Point s11 and 21 define the direction of the glass insertion - The points must be
located on the 2-D part GLASS

Point s12 and 22 define the glass thickness - The points must be located on the 2-D

part GLASS

Point s14 and 24 are required for the “Change glass in insert” option. These points are
not mandatory - The points must be located in the 2-D part GLASS

Points 15 and 25 define the position of the mounting bores on mullion and transom >
The points must be located in the 2-D part MULLION and TRANSOM, respectively.

7

4 20

221

1o

17

- 4

11

L10

-

==t

“Azd P?

21 20

o o1z M4
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The Metal Engineering Design Variant can be used for the following design tasks:

> 6.1 Create User-Defined Beam/Profile Cross-Sections

0 Here you need to create Points 15 and 25, in addition to the glass insertion
points, in the part Mullion and Transom, respectively.

» 7.2.1 3-DImport of Individual Beam/Profile Cross-Sections via LogiKal

0 Here you need to save the individual mullions and transoms (not the entire
beam/profile group) together with Points 15 and 25 to the ...Catalogues\Factory
standards\LogiKal directory beforehand (= 7.1.3 Simplified Beam/Profile
Cross-Sections in the HICAD Catalogue).

» 7.2.12 Facade via Metal Engineering Grid (Metal Engineering Plugin)

o For the placing of beams and profiles on grids you can use either user-defined
beam/profile cross-sections, or beam/profile cross-sections imported from
LogiKal (see previous Chapters 6.1 und 7.2.1).

For the creation of the 3-D Metal Engineering connection you can use two calculation methods: .
Calculation method 1 is used for connections where the cover strips have the same width as

the support profile.
Calculation method 2 is used for connections where the cover strips are bent (angle-shaped).

[l 3D Metallbauanschluss fiir Schilco FW50/60

v

- Here you can create and save user-defined or

SRR . ' manufacturer-specific connections.
|Testor : - @ |
|2l x](=]) |
51 |2 - Defines the clearance between mullion gndg transom
52 12 - Defines the clearance between the cover s_tirips
M '_1;1 - Defines the clearance between the mulﬁdnféaxis and the start of transom
B [42-  Width of slot in transom -
L {7 . Length of slot in transom g
ojaa. Diameter of bore in mullion for the mouﬁt_in% of the transom
+ | Zushitziiche Langlocher erstellen :
A fso. Creates additional slots in the transom, witl:' a distance of 50mm

| Zusatiche Bahrungen erstelien
H |- Creates additional bores in the mullion for the fixing of slide-in profiles on the transom. The distance
is measured from the bottom edge of the transom.

. Bohrungsparameter ————————

Bohrungstyp -
¥ Normbohrung ~ Menndurchmesser: |3 |
" Langloch Bohrungsdurchmesser:|3.2 1 i
r T, |
Fiachinct - Here you can specify various bore types with a bore pattern.
 Freia Bohrung
mux— mu'r— - Definition of the bore pattern for the selected bore
Anzahl: | 1 = | Anzahl: |1 - | type.
Berechnungsverfahren: |1 =| _ Definition of the calculation method (see next screenshots)
Zubehar
r:_-‘ | - Here you can create accessory parts that are
> : required for the connection, and save them together
Sachnummer  Anzahl  Mengenein  Werkstoff Bemerk | | with the configurations.
Zubehie 2 Stiick Ededstahl Sond |
SCc217585 |1 Shilck Kunststoffdichtun | Dichtsti |
|sC129430 |1 | Stuiek | Alurminiuem [ 7-verbi [=]
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For insertion, first select the transom, and then select the mullion.

E 3D Metallbavanschluss fiir Schiico FW50/60 -3 x|

~ Konfiguration
[Testor -| @

‘E Regeleditor...

Ge

s1 [2 -]
2 [z -
M {10 -]
B |4.2 v|
L[z M
D (32 ~|
Zusstzliche Langlicher erstellen

A [s0 -

Zusatzliche Bohrungen erstellen
Ho [10 -

— Bohrungstyp — — Bohrungsparameter

(% Normbohrung ~ Menndurchmesser: \:\
Ef
Clondoch | pohmngedurchmesserfz |

I~ Rechteck

" Freie Bohrung H S 1

—RasterX —————————————— -~ RasterY — ' _
-

Berechnungsverfahren:

(=]

B T T2 T o oo + scaniDauanschluss fiir Schiico FW50/60 i [s=] 3]
D ~ Konfiguration
[Test 01 -| @
Sachnummer

@ Regeleditor...

SC217585

|sC 129430
51 (2 v|
52 |2 v|
M 10 -
B |42 -
L [ 5
D [32 ~|
Zusitzliche Langlacher erstellen
A |50 -

Zusitzliche Bohrungen erstellen
H o |10 -]

gstyp — — er

(% Normbohrung Menndurchmesser: 3
EE
" Langloch Bohmngsdurﬁmmr:\:\ —

" Rechteck

W
=

€ Freie Bohrung

—RasterX ———————————— ~RasterY ——
-

=

Berechnungsverfahren:

Sachnummer  Anzahl Mengenein  Werkstoff Bemerk

[scizeqa0 |1 | stiick | Aluminium [T-verbil (=]

oK H Schliefen Hﬂbemehmen
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12.2 Fixing Bracket for Intermediate Ceilings

Use this Design Variant to attach facade mullions to building structures. This variant can not
only be used for aluminium facade profiles, but also for hollow steel beams.

First select the mullion, then select the building structure, and finally select the insertion point.
The dialogue will then be opened, enabling you to configure the bracket.

The different configurations can be saved as templates.

[l 30 Metallbavanschluss fiir Sch? .o FW50/60 I ] 1
Konfiguration -
| ~| (A
m mm Regeleditor... S \/‘/_\ - -",7-
4 N e r
Eometriej)arschraubungen l Bleche ] m - /"" - p
5 |3 v| i ‘ '-
H [0 -] .
e £ d H [
v [ g —t - H
we [ -] | ®
k: (a0 - G ' 7
Gesamtiange: | 100 ~| ‘ ~1 / ©
esamtlange: . \
A an Ny
- o ¢ I"’
Geometriz - _
— Am Profil
Umdrehen
Schraube: |DIN EM IS0 4014-M10-5.6 | -
Bohrung : [M10 (& 10,5) L=30 W=0 |
— RasterX ——— — RasterY
Versatz: [0 | versatz: [30 | [ ok || schlieben || tibernehmen
“|  Anzahl: |2 v| Anzahl: |1 v|
! Geometrie [ ‘u’erschraubun@ | Bleche )

— Halbzeug ( Platten A )
— Am Anschl eil |

Bezeichnung: |BI 8
Anker - Verschraubung

Werkstoff:  [5235IRG2 |

Schraube: [HILTI HST DURCHSTECKANKER: M10]

- Halbzeug ( Platte C )

Bohrung : |D=1D | Bezeichnung: |BI 8 | =
“RasterX — ~RasterY Werkstoff:  [s2357RG2 |
Versatz: |0 | Versatz: |3u |
Anzahl: |2 ~| Anzahl: |1 - - Halbzeug ( Platten B )

5 Bezeichnung: |BI 3 |

Werkstoff: 5235162 |
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The intermediate ceiling can also be placed at a
specific angle to the mullion!

Changes:

- If the width of the mullion or the position of the facade is changed subsequently, the
connection needs to be recalculated via the Feature log, and all connection
constellations will be automatically adjusted to the new situation.

- To change bolting parameters, such as slots, bolt sizes etc. subsequently, double-click

the corresponding Feature log entry. You can then change the Feature log entry as
desired.

The updating of the connection can either be performed via feature recalculation, or via the
Steel Engineering module (Variants > Update).

The Feature log entry “Wall mounting” can be broken up into its individual working steps:
- Right-click Feature log entry
- Select “Break up variant”

MNeuberechnung
Feature

?: 32 i3 %‘: Big zu diesem Feature berechnen

-4y’ (1) Wandbefestigung Right—click Teilepositionierung
2} --- Einfii it
=@ intugeposition Altuzlisieren
Variante aufldsen ]
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13 Exercise: Create Metal Engineering Facade
Construction

13.1 Construction of the On-Site Scenario via 2-D DWG Data

HiCAD provides the Metal Engineer with a tool that enables the representation of the on-site
situation, and a production-oriented integration of Metal Engineering constructions into the
displayed scenario.

1) In the present example an imported 2-D dxf/dwg file is transferred to a 3-D CAD drawing. To
do this, first load the file BUILDING2010.DWG from the “Szenen” sub-directory of your
HiCAD installation.

» Open the Drawing tab and select -
New/Open > Open - Interfaces, I & wro
DXF/DWG... l

2) To construct the wall, first switch to the top  f....... usstellung fj
view according to the World Coordinate | inae
System. Create a sketch (the processing | -
plane will be placed in the screen plane).

3) Use the Copy 2-D polylines function to copy s : | Linienzug
the 2-D lines to the 3-D sketch. 20
» Activate the Sketch tab and select Derive > Copy > Copy 2-
D Polyline.

Now process the sketch in such a way that a closed polyline will
be the result (see screenshot).

4) From this sketch, create a Wall (masonry) with a height of 2000 mm, using the Solid ﬁ[;i

Construction catalogue (Metal Engineering > Part type - Solid construction). Teileart

5) Create two further views:
- Alinked front view (right-click on pink dotted view frame, or open Views tab)
- A axonometric view (right-click on pink dotted view frame, or open Views tab)

73

When working with several views you always need to activate the view that you want to
process. To do this, click the view frame of the desired view. The active view is indicated in the
Views tab of the ICN.

il
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a.
- |
6) Creation of the base plate o6 1L i

- Activate top view. : \\:
- Create sketch and use the |

sketching options to draw a |

rectangle for the base plate. - hussletlng

For an exact positioning of

the sketch you can also use

HCM options. T
- Right-click  sketch and )

create extruded part with a

height of -150 mm. @
- The base plate will be

automatically represented in s

all views. -
- Familiarize yourself

with  the  different

representations of

views, such as Hidden _ _

Line, Shaded with i

edges etc... . . A . ]I

i S

ey

(1) wand
‘[z Gesamtlange: 2000

- Darstellung: vereinfacht
S Skizze

-1} Bearbeitungsebene: -
-2 Kommentar

- Bedingung: 1

‘B Sichtbarkeit: -1

(2) --- Einfiigeposition ---

7) In the Feature log of the “Wall”, double-click the “Total length”
entry to change the height to 4000 mm.

[Z0E HCM  Grafik  Eigenschaften
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8) Apply subtraction via translation to facade
- Activate top view

- Create sketch and place processing plane on base plate. Use the
sketching options to create a material subtraction via translation. | remsdvage [0

The subtraction must be made by means of a closed polyline. ] +Z Richtung
H « » . . (") Dynamisch
- Activate the part “Wall” (Solid construction). e —
- Open the 3-D Standard tab, select the “Subtract with translation + () Bis nachste Austrittsfiache

depth” function (“Process with sketch” function group), and apply @wert [ 3000
the previously created sketch (subtraction contour). For the depth | [-zrichtung
specification, set the value in +Z direction to 3000 mm and confirm

with Subtract.

)

besitribmy

_____________

| —»| Subtraction contour

| Feature

ioozoai
(J o ¥ (1) wand
[-1-i8 (3) Ausnehmen translatorisch

+Z-Tiefe: Wert
-Z-Tiefe: unbenutzt
E:d wWinkel 0
-/ skizze
‘= Skizze bearbeiten

T~ k] aden
' = Skizze austauschen
i =¥ Teil ausblenden

. . -+= Teil einblenden
9) The subtraction contour can be changed via the Feature log entry };Lu:i:fﬁeu.llﬁ-}.
“Sketch, Process” at any time. You can also use HCM options here. 5 bearbeitetes Tel: -
-1} Bearbeitungsebene
Kommentar

[rindriss

Bedingung: 1
4= (2) — Einfugeposition -—

10) In the 2-D Part structure, subordinate the part “BUILDING2010” to the view “2-D Model”.
In this way you achieve that the 2-D drawing

will only be displayed in the “3-D Model, ‘oo — =
View” area, but not in the Sheet areas. ) ¥ o ol s s 2 23 55 gl
g BLILDING2010

-a® Ansicht 4
2D-Modell
4a® BUILDING2010

L)

EDRIEL Il 2D-Teilestruktur
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13.2 First Draft of the Facade

11) Draw the route of the facade with the help of a sketch. Assume that the facade route is
based on the outer edge of the glass.

- Activate the top view.

- You create the sketch with a processing plane placed on the base plate, and use the
sketching options to draw the route of the facade. You can also use HCM options here.

90

Y1

12) After drawing the route of the facade, use the Metal Construction plugin to create a
facade planning grid. Proceed as described in Chapter 8 Facade via Metal Engineering
Grid (Metal Construction Plugin).

- Take the dimensions of the facade from the screenshots below:
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13)

14)

Metall Konstruktion x
Grundtyp: Example Polygon Facade ~
Konfiguration: @

- Grundparameter -
Anzahl der Segmente:

Anfangswinkel:

Fulkanten Winkel ()¥-Eben MNeigung
1 2185 o S0 o0
2 59414 1 225 10
3 19614 2 120 2 0

[ Gleich setzen ” Gleich setzen H Gleich setzen |

~Pfosten . Riegel )
Anzahl: Anzahl:
C 200 - 120
1 [ 11383 1 [ 920
2 [ 1383 2 [ 920
3 [] 11383 3 [] 920
4 [ 1383 e [ 120
5[] 11383
o 50
Gleiche Riegelverteilung fiir allz Flache:
i~ Erweitert... ;

Bemafiungen darstellen
[ Meu H Speichern ” Speichern neu |

[ Ubernehmen ” Abbrechen |

After applying the created grid to you drawing, create a grid assembly.

E--fr_’jJPosiﬁon 1 {Baugruppe} &

Activate the Metal Engineering tab and select Grid > Grid e
assembly, new. -5

- iFlache 13 &
- iFlache 23 &
“@Flache 33 &

F—Iﬁ— . Pfosten {Bauaruppe} £+

== i)Riegel {Baugruppe} T

[ﬁ[‘j i) Glaselemente {Baugruppe}
{i~ i) Einsatzelemente {Baugruppe}

For the placing of parts on the grid, proceed as described in the following chapters:

Then subordinate the sketches of the grid to the Planning grid
assembly.

For a placing of beams/profiles on the grid via LogiKal, please read the information given
in Chapter 7.2.12 Place Beams/Profiles on Grid via LogiKal. Please also consider the
beam/profile insertion points described in Chapter 7.1.2 Metal Engineering Settings.

For a placing of beams/profiles on the grid via user-defined beam/profile cross-
sections, please read the information given in Chapter 6.2.4 Insertion on Grid via User-
Defined Cross-Sections. Please also consider the beam/profile insertion points described
in Chapter 6.1.8 Define Insertion Axis.
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64

Fassadenkombination mit Verglasung [d:\hicad2012\templogix gichex

Serie:

v

Asveshl Standard v
Glasleisten-/ aniation:
Sireie Swiod o]

Arzahl Glasscheiber:

oben: E unter: E

Glasaufbau oben:

Glasaufbau unten:

S

o

izl ol ol o el
F [ m

At der Abknickung:
= ohne
i~ Aubenecke
"~ Innenecke

‘wfinkel der Abknickung: |0 -

Fassadenkombination mit Verglasung [d:\hicad2012\templogix

x|

Yorschau

||}

Fassadenkombination mit Verglasung [d:\hicad2012\temp\logix

Art der Abknickung:
+ ohne
" Aubenecke
" Innenecke

“Winkel der Abknickung: IEI *

Serie: v|
Auzahl Standard -
Glasleisten- ariation: Standard ~
s foded

Anzahl Glasscheiben

oben: E unten IG
Glasaufbau oben: IT IU_ IU_ ID_
l_

Glazaufbau unten: 32 ID il 0
= e ]

Fassadenkombination mit Verglasung [d:\hicad2012\temp\logixi

For the placing of parts on the grid via LogiKal, you can use the following beam/profile

combinations:

Pfasten T05rmm:
lzalatorprofil 25mm;
Prrofil 3:
Glasdichtung:
Andruckprofil Gest.:

Sal ==l
o oo oo
— || L
—‘h%!\ll\)
IE IR
=S ol = o e
2| 8| o) &|=
=
=
s
5
2
Elo
<l llellell=
[

Yorschau

1.

Deckschale 15mnm: EC 112720 i
Zuriick Eertigstellen | Abbrechen |
x|
Fiegel 110mm SC 322420 v
|zolatarprofil 25mm: SC 224809 v
Frofil 3: SC OHWE BUTYLA v
Glazdichtung: SC 24468242-BA1 £
Andruckprofil Gest. SC 11270 w
Deckschale 12mm: EC 160620 w
Zuriick FEertigztelen Libbrechen
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13.3 Create Drawing for Approval

15) For the creation of a drawing for approval, switch to the Sheet area, insert a DIN-A1
drawing frame, change the Main scale 1:25 and create several Sectional and detail
views.

» Open the Views tab and select New - New sectional view / New detail view.

- Change the view scale of the sectional and detail views to 1:5, the axonometric view to
1:50.

- Switch the view representation to Hidden Line

- In the detail views X and Y, the superfluous profiles can be deleted. These superfluous
profiles were created during the placing of elements onto the grid.

X (1:9) Y (1.5)

- When deleting the profiles, please make sure that the Group snap option is active. (see
Chapter 5.1.5 “Group Snap” Mode.

- Now proceed as described in Chapter 11 Create Wall Connections (3-D) to construct
the wall connections with plates, foils, insulations, sealings etc. ...

Yor1:2)

—{=150 15481=-5T3, G=19=-A2=H

TTBlech iamen

TS0 15481-5T3, 8x19-22-H

Isolation weich

i
“~l¥olie Dempidicht

- Then, dimension and annotate the drawing for approval.
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[CEILNLE TR CF

[EIETRISCICoTAN

H=Z¥-B1“GELS-LA7G 05+

wmuur e g

H=Z¥-B1“GELS-LA7S L D5 [

5ik) I

_x..n une yas g

(SR

&7
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94

Li
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b
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13.4 Fit Window Insert into Facade

- Proceed as described in Chapter 7.2.9 Change Glass in Insert.

13.5 ICN Structure

Before itemisation and workshop drawing creation, the =%  [Fassade {Baugruppe} O

ICN structure needs to be arranged appropriately. The Eﬁj Pasition 1 {Baugruppe} {
screenshot on the right shows an example of such a il Adhsraster {Baugruppe}
structure Pfosten {Baugruppe}
' [ Riegel {Baugruppe}
- To create a new assembly, open the 3-D Glaselemente {Baugruppe} 7

ﬁp Einsatzelemente {Baugruppe} {}

E]---'Eﬁ Blechkantteile {Baugruppe}

- You can move the 3-D parts in the 3-D Part % AufmaB {Baugruppe} O
structure via Drag & Drop. E-%  Wandanschiuss {Baugruppe} {}

3D-Teilestruktur

Standard tab and select New > Assembly.

Fl
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%

Auto..,

68

13.6 Itemisation / Workshop Drawings

To be able to create a workshop drawing you need to itemize your CAD drawing beforehand.
To do this, open the Drawing tab and select Itemisation/Detailing - Iltemisation.

- During itemisation,

(geometrically) identical part search takes

place.

- The item numbers will

parts and assemblies in the ICN structure.

- Choose Drawing - Itemisation/Detailing >
...with options
Itemisation dialogue window.

Auto >

- Here you can specify the desired settings for

itemisation.

an automatic

be written after the

Positionsnummer

Baugruppen Il— ( Startwert )
[100 | (Stertwert}
[10000 | (Stertwert}
Teile, allgemein IW { Startwert )
[] schweiBnzhte |2-J-J-3-J (Startwert)

Startwert =

IEartwert j

Hauptteile immer zuerst

Stahlbauteile

Normteile

|:| Vergebene Nummern sperren

E|"1': {Fassade {Baugruppel} {5}
E-fi Position 1 {Baugruppe} A8}

to open the B
&% Aufmal {Baugruppe} 32
E]...‘HE

et Acheraster {Baugrfippe} J0}
- Pfosten {Baugrugpe} {7+
¥-%= Riegel {Baugrupde} {9}

[ﬁl‘f Glaselemente {Bduaruppe} {6}
fi.’-” Einsatzelemente {B

Wandanschluss {Baugrdgpe} {10}

Referenzierung

(@) Ohne
(©) Intern

(©) Extern

x
Azu Esmomerenda Teile Filter
@ Alle
B Ohne hd
(71 Alle sichtbaren
() Alle in aktiver Ansicht sichtbaren Kenfiguration
-{Posihonieruné éleicher Teile
@ Fortlaufend, gesamte Konstruktion
() Innerhalb Baugruppe, gesamte Konstruktion
(" Innerhalb Baugruppe, aktives Teil + Nebenteile
Anzah| Nebenteil-Stufen Alle -
([Bei Positionierung zu beriicksichtigen: |
[] Teileattribute
{Bei geometrischer Gleichteilsuche zu beruecksichtigen: F——————————
Verschraubungen
[] Fertigungsart von Bohrungen {Werkstatt, Baustelle, ...}
[ SchweiBnahte
Mathematische Toleranz fir Facettenvergleich 0.001

INur neue und gednderte Teile positionieren

|

2-D/3-D Metal Engineering



Exercise: Create Metal Engineering Facade Construction

Create plan of model glass panes:

- First step: Open the -ioix -
Part attribUteS dialogue Teilename |2‘|4-5‘I44220 Sticklistenrelevant = %
window .Of the glass Sachnummer [GT 01 AnzanijeTeil [T
pane (C“Ck the cross Ze\chnungsnummerl Mengeneinheit I—;,

SymbOI 0':] the gIaSS F'osmonsnr—Texil Positionsnummer I‘IZZ—
pane_ or rlght-C“C!( the Beschichtung innen I— Beschichtung aussen I—
part in the ICN or in the breite [ 896,00 Menge1 [ 000
drawmg area and select Lange [ iz N T
Pro.pertles >  Part Hohe [ 3200 Mengez | 000
attributes. Abmessung 1 I— Oberflache |—1.00

- The Part attributes Gewicht I 4271 [ Fixiert
window provides WerkstoffMaterial [Glas ]
information on  the Venwendungsart | ||
active part. This Benennung 1 |
information can also be Benennung 2 |14x GT 01-1114.284 Clas
evaluated in the Bill of Bemerkung |
Materials (BOM). Systemhinweise |

. Teileart |Glasscheiben

- The Article number e

GT Ol is to be used as

----- ® 5T 01 {Glasscheiben} {122}
----- M G701 {Glasscheben} {122}
- Then, open the search mask and enter the search | = = i~ M G701 {Glasscheiben} {122}

- P A T TR I S S ™ GT 01 {Glasscheiben} {122}
criteria, as shown in the screenshot on the next | = ® o701 {Gasscheiben) {122}

a filter criterion.

page. ... ® G701 {Glasscheiben} {122}
----- ™ G701 {Glasscheiben} {122}
----- M GT 01 {Glasscheiben} {122}
----- M GT 01 {Glasscheiben} {122}
----- M GT 01 {Glasscheiben} {122}
----- M GT 01 {Glasscheibent {122}

3D-Teilestruktur EEEEREIE T
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Zeich...

-

70

inix
Suchen  Bearbeiten  Ansicht  Ausgabe
X m=(b K @rHEaepNe

Teillename

Typ:

r ILeeres Teil

Farbe:

- [- Black

Schicht:

r | 1 bis  [aag

Paositionsnummer:

M [1288
Werkstoff:
- IGIas

Datenmodell:

r IExakt

T_Sachnummer:

Kl

Bauteilstruktur Typ

4

Auswahl in ernehmen

HLéschen

Umbenennen
BlFarbe dndern
S4schicht dndern

12145144091}

l

Werkstoff

|

T_Benennung:

i

D_Dokumentnr.:

]

D_Benennung:

i

D_Freigabe:

]

ummer:

W [cTo1

™ [Pfosten 125

Benennung 1:

]

R.+I-Symbolzuordnung:

|
Jetzt suchen I

Suche abbrechen

[T Grob-jKleinschreibung beachten

- Select “Take over selection in ICN” to create a selection list in HICAD (this selection list

- Positionieren
Stlickli

Teilename |2145144225

Stiicklistenrelevanz

Sachnummer IGT 01

Anzarrreren T

Zeichnungsnummer |

Positionsnr-Text |

Beschichtung innen I—
Breite Im

Lange IW

Hone [ 3200

Abmessung 1 l—

Gewicht

Fositionsnummer |124

Beschichtung aussen l—
Menge 1 I—DDD

Menge 2 I—DDD

Menge 3 I—DDD

Oberfliche I—DBS

[~ Fixiert

WerkstofiiMaterial |Glas

2

Verwendungsart I

Benennung 1 |

Benennung 2 |6x GT ff931.711 Glas

Bemerkung

Systemhinweise

Teileart |

Anderungen Ghermehmen | V¥ Anderungen automatisch Ubernehmen

can also be created manually in the ICN).

- For

the active selection list,

select the Drawing derivation

Itemization/Detailing - Drawing derivation).
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- Fill in the dialogue for drawing
derivation as follows: e o)
IIn worhandene Szene j

Extern erzeugte Zeidﬂnungen]

IErsteIIte Szene schiiefien j
Blattauswahl Ausrichtung von Baugruppen——
IEin neues Blatt ﬂ IFerﬁgungsIage j

{Z7u erzeugende Ansichten fiir:

Teileauswah

[ Baugruppen ]
Profie [ Profile ]
Bleche [ Bleche ]
Kantbleche [ Kantbleche ]
[] Allgemeine Teile [ Allgemeine Teile ]
Zu erzeugende Ansichtsgruppen fur: }, {Einstellungen fiir:———
Hauptteile als Baugruppe [ Zeichenblstter ]
[ Hauptteile einzeln [ Ansichtsgruppen ]
Nebenteile einzeln [ Ansichten ]

[ Blechabwiddungen ]

C T I N |
Zeichnungsparameter
¥ (7) Im Dialog setzen

Einstellungsdatei

[Speichem] [ Laden ] [SpeichemJ [ Laden

- On the Views tab of the ICN,
create a second Sheet area containing the model glass panes.

- To insert the BOM for the glass Sheet area, proceed as follows: Right-click on the
Glass elements assembly, and select Bill of Materials, for active part function. In the
Report Manager Configuration area, pick the “Glass” option from the list box, and
select Output to HiCAD.

1 1

[ SHEET_LEWGIH 1114 ‘l ‘l SHEET LEWGIH G965 I I SHEE1_LENGTH 9 I
§ £ £
] E E
3 2 2
¥ ¥ ¥
- =
T O S 122 o oot ans 123 i ohaskean/ans 124
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72

Create production drawing for the transoms:

- The procedure is the same as for the creation of the model glass panes.

- First, open the Part attributes window of the transom.

=10Ix|

Teilename 2127148859

Stiicklistenrelevant i

Sachnurmer [SC 322420

Anzahl je Teil I‘l

Zeichnungsnummer I

Mengeneinheit | vl

Positionsnr-Text I

Beschichtung innen I—
Breite IW

Lange Im

Hohe [ 0000

Winkel untenfiinks-xz [ 0,000,
winkel unteninks-vz [ 0.000
Abmessung 1 I—
cewicnt [ 2483

Positionsnummer I‘IQ.S—
Beschichtung aussen I—
Menge 1 I—

Menge 2 I—

Menge 3 I—

Winkel obenirechts-xz [ 0000
Winkel obenirechts - YZ IW
Oberfiache [ 046

[~ Fixiert

WerkstofiiMaterial IL&iChTmeT.aII

Verwendungsart ITrag profil

]

Benennung 1 |

Benennung 2 IED:( S5C 322420-1118.284 Leichtmetall

Bemerkung |SC FW 50+ =02

Systemhinweise |

Teileart [Riegel 110mm

Anderungen iibernehmen

Abbruch |

- You can filter by Article number or Part type (as for the model glass panes). This
procedure enables you to create only the production documents for the transoms in the
next step. The same procedure can be applied to the mullions etc.

- In our example we will filter by Material, so that all light metal parts will be created in

one Sheet area.

- Open the HICAD search mask and fill in the search mask as follows:
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il

Suchen  Bearbeiten  Ansicht  Ausgabe
Blxm=|d X @& e pxe

Teilename Bauteilstruktur
a1

Typ Farbe Schicht| Posi... | Werkstoff Modul T

Teilename:
~ =
™ stiickiisten-{nichtjrelevant

Typ:

r ILeeresTeiI j
Farbe:

r [- Black ]
Schicht:

r |1 bis  [agg

nsnummer:
1239

Wwerkstoff:

W [Leichtmetal

Datenmodel:

r IExakt j

Positionieren

T_Sachnummer:

Stiicklistenrelevanz L4

Anzahl je Teil |1

Fositionsnummer ID—
Beschichtung aussen Ii
Menge 1 I—
Menge 2 I—
Menge 3 I—

Oberflache 0.03

| Teilename |2145144017

T_Benennung: Sachnummer ISC 284321

r | Zeichnungsnummer |

D_Dokumentr. Positionsnr-Text |

| Beschichtung innen I

D_Benennung:
rl
D_Freigabe: Hihe
I Abmessung 1
Sachnummer: Gewicht ' [T Fixiert

r [&roz Leichtmetall -

Select “Take over selection in ICN” to create a selection list in HICAD (this selection list can
also be created manually in the ICN)

- For the active selection list, select the Drawing derivation (Drawing - (= =]
Itemization/Detailing - Drawing derivation). |_md

- To apply the settings for the production drawings, proceed in the same way as for the Zeich...

model glass panes. After this, detail drawings will be created on Sheet 3 for all light =
metal parts.

S0 3724203936/ Leichimetoll 135

1051?
1
1

| 936 }
15
I
‘% =l
1
at %Jb

E:
E:
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- To insert the BOM, mark the assembly E"'hé_,ﬁ_fas?piifﬁiaﬁauapup;ié;};} 8%}

“Position 1”7, create a BOM of the active part, g
and import it to Sheet area 3. ]E*_r_ Sg:g:t;f;ﬂ:;pﬁ}{n}

== Riegel {Baugruppe} {3}
[ﬁf Glaselemente {Baugruppe} {6}
ﬁ‘-’ Einsatzelemente {Baugruppe} {4}
F-*%  Blechkantteile {Baugruppe} {3}
F-%%  Aufmal {Baugruppe} {2}
F-%f  Wandanschluss {Baugruppe} {10}

13.7 Transfer to LogiKal (only available in conjunction with the
LogiKal interface)

For the transfer of elements to LogiKal please read the information given in the following
chapters:

- 7.2.4 Transfer of Beams/Profiles to LogiKal
- 7.2.10 Export Facade / Insert to LogiKal (3-D)

13.8 Machine Control (Profile Machining Centre PBZ)

Machine control can take place in two ways:

- For machine control via LogiKal the reading of the following chapters is recommended:
0 7.2.4 Transfer of Beam/Profiles to LogiKal
0 7.2.10 Export Facade / Insert to LogiKal (3D)

- HIiCAD NCX Export file. Please note that the drawing needs to be itemized for this

procedure.
o Saveas = MNCX x
[Makimaler B ohrungzdurchmesser: 200 mim ]
[ @ Camprax () Camaelean ]
[Alle Bauteile in gine Datei schreiben: ]

Mame der MCx-D atei:

Namen der DF-Querschnittsdater:

@ Querschnittzbezeichnung plugs Positionshurnmer
(1 nur Querschnittsbezeichnung
(1 nur Positionsnumrmer

[ Aktives Tal ]
[ Eifctive Teileliste |
( 2l Teile ]
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14 Exercise: Section and Detail Planning | S
For this exercise, please load ] _ E ] ]
the HiCAD drawing | |

Glass_Facade.SZA in the
“Szenen” directory of the
HiCAD installation. This
example will show you how
easily a detail planning of the

wall  connection for the | . < . O I
approval drawing can be =
performed. .
g :_—| Vo N | "F
Please also note the “u

information given in Chapter
11 Create Wall Connections

(3-D)!

In this exercise we want to create the wall connection in the detail view Z (1:2). Proceed as
follows:

Activate the detail view in the ICN structure.

AT

- Select Metal Eng., 3-D Section - Part with Material. Ij :[J_I
- Fitting mode: Part from rectangle, Part type: Concrete, reinforced -> OK. wﬂfétm
- Sketch a rectangle via 2 diagonally opposite points. Change the exact dimensions via the
Feature log entry “Sketch, Process”. The sketches can be conveniently modified via the
C-Edge-HCM.
- Select Metal Eng., 3-D Section - Sealing. lkg
- Choose the desired options, such as Steam-tight, In-house production etc. > OK. W‘rsi;g
- For insertion it will be sufficient to identify two edges in the sectional/detail view. The
edges do not need to run parallel. The sealing cord will be created automatically.
- The insertion of the Part type “Insulation, soft” also takes place via the Part with Material o
option. )
- Fitting mode: Part via contour search, Tolerance: 2, Part type: Insulation, soft. Werkatoft
- Left-click the area. Contour + 3-D part will then be created automatically.
- Before creating a 3-D Foil we have to draw a sketch indicating the route of the foil. &)
- After selecting the Foil option it will therefore be T Folie

sufficient to identify the polyline of the previously

created sketch. Before inserting the foil, you will be 7 o,
asked to specify the insertion direction of the foil 10 ///////
. . . . . o ////
(i.e. the direction of the foil thickness). ??///?é
- After updating the sectional view, the correct | /????/?
hatchings will be displayed. VY ;???ééf
- In the other views the parts are hidden. ?????é?
- After showing the parts in the front view, they can ??f??///
be processed further with Steel Engineering ; 7 ?fj//// ;
functions, such as Trim, Change length etc. ... é/é//////
- For part annotation, all set parameters will be read 4 /§ s
out automaticall 507
y- T
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Y 15 Exercise: Staircase with Glass Canopy

15.1 Learning targets

Create a 3-D CAD drawing of the geometries existing on-site

Insert beams and profiles in the drawing via the Catalogue

Familiarise yourself with the different insertion options

Place beams and profiles in certain positions to each other and duplicate them
Process beams and profiles and bolt them together

Create and process Steel Engineering plates and glass panes

Store and use purchased parts in the Catalogue

Create documents for customers, architects, production
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15.2 Create the Existing On-Site Situation

First, use extruded solids to construct the existing on-site scenario.
m Create the sketch of the base plate in the XY-plane of the World Coordinate System.

Weues Translationsteil| s

Startpunkt A D00

o { Hohendefriian
F
@ Wareingabs
—_ Formzchrace I 0
Warkstoff Beton =
= Stathiche I il
ﬁ 1\%; Enchithe |H|—
Skizze fiir Querschnitt

nach Erzewgen [gschen

m  Create the sketch form the wall in the XZ-plane of the World Coordinate System.

Fo00
1500 Moo S0 240 Meuwes Translationsteil| 52
| Hehendshritior]
= @ 'wetergabe
k= L
=
Formachrage I 0
Statthhe ID
Enchidhe 240
- Werkstofl Mauerwerk
=AR= Skizze fiir Querschnitt
T £ @
nach Emeugen lizchen
] [7] Referenzien [ Feature
§ {Tailanama]—
|wnm3
g |
[t}

HiCAD offers the option to change the part type of extruded parts via the part type catalogue.
Open the Metal Engineering tab and select Process, LogiKal 3-D - Change part type.

The procedure assigns a colour and a material to the parts. You can adjust these settings to
your individual requirements in the Catalogue Editor, and modify them if desired. This also
ensures that the correct hatching code will be used in the (later created) sectional views of the
on-site elements.

Bodenplatte [Eeton) L
Ka[E)
= Teilsartan (82 |[TE=T |
Baugruppen ) b sSocenbelag Erzaugt ads worhandener Skizes Translatiorstel als Haupctel
E’E‘:h_‘mb':t"'k“”” 3 5ocenplatte iBston)  Erzsugr aus vorhardener Skizzs Tramslationstel als Haupctel
== = ) B Dach Erzzugt aus worhardener Skizes Translationstel als Haupcted
i Mecharische Konskroktion . .
B Furdament (Retan) Erzaugt aus warhandener Skizes Translatiorsted als Haupched
i-[F=] Metallbau f Fassadenbau ! ) )
oaHban P Halz [bauseits) Erz=ugt aus vorhardener Skizzs Translationsted alz Haupctei
B Verputz Erzsugt aus vorhardener Skizza Translationsted als Haupcked
B Wand [EBaton) Erzsugt aus worhardener Skizzs Translationstel al: Hauptbed
B Wand [Mauanuerl) Erzzugt aus vorhardenar Skizes Translationsted als Hauptbed

Use the HCM constraints for the determination of door cut-outs, in order to be able to
conveniently apply later, more precise dimension specifications to your drawing if required.
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Exercise: Staircase with Glass Canopy

15.3 On-Site Structures
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Exercise: Staircase with Glass Canopy

15.4 Staircase

For the staircase it is recommended to draw the contour, i.e. the division of the steps, by means
of a sketch at the location of insertion. Place a sketch on the wall and move it 30 mm away from
the wall. Draw the contour of the staircase into this sketch.

1080 (4270 1400
= ST
= o
= ,f
s
_ -
-
| |
| |

= Place the wide flat steel 10x220 in 3-D via the end points of the sketch. Switch the fitting
position to Top axis and rotate the profile accordingly.

= Mitre the wide flat steel at its joint, and
trim it at its start using the Trim to edge
function (the result can be seen in the
right screenshot below).

el Wil JRteY BT RT RN
ERED

|&3 TREFPEMITWORDACH_DOKU

S0%  Bauseils {Baugruppet {)

i @ Bodenplthe i

E WAND [} 4}

-
g EE Treppe B augrappe} {]
== Tieppenviange links {Baugnppeh
BRFL 10220 {F lachztah} 0}
BRFL 10220 {Flachzt=h} 0}

It is recommended to structure your parts into assemblies right from the start. This will enhance
the clearness and facilitate the identification of parts. Parts can be conveniently moved via Drag
& Drop, or by cutting and pasting them in the structure browser.
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E4

m Use a flat steel 80x10 with a bore D14

for the base plate of the stair stringer.

Use the Trim beam, to surface
function to cut the stringer to the base
plate.

70
70 40
An angled steel frame made of 40x5

L-profiles forms the sub-construction

for the steps. Create an assembly “Step”. You can initially construct the frame freely in
space, and then move the “Step” assembly it to the desired position with the Transform >

Move, 2 points function.
Now copy the “Stair stringer left”
assembly to obtain the other side of
the staircase.
Rotate the base plate using the
function Transform - Rotate part,
via 2-D point in the top view of the
glass model.

Change the designation of the “Stair
stringer, left” to “Stair stringer, right”.

Now create the actual step in the | Bef Suk Beuupee Montaoc) 0}

assembly “Step” as an extruded solid @ = g Schreubverbindng b {0

(Height: 30 mm) that is placed directly on the i g Schraubverbindung (3 0%

angled steel frame. Define the geometry of | = E®Y Rahmen {Baugrippe Werkstatt} (0} -
the sketch via the HCM (20 mm projection, 3~ | Ll r

mm distance from stair stringer). Assign the  zp-Teilestruktur 20 Teilestrulktur
desired material and an appropriate

80

! i Slgenscnatten B
designation.
Bezechrung | wert
. . Typ | TRAMELATIOMETELL 0
The transparency of the step is obtained by Feme T2
L ] . : Schicht B betongrau [52]
assigning Layer 40 to it (via Properties). prT—— a0 grau [32]
;DS:'T Maturstein dlgemein
_Datenmogel [ starcard
| i T Tt 1 (LTI Stiddstenrelevant "Eakt
.,

I R
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Alternatively you can also define “Steel Engineering plates” with the Material “Granite” and the
corresponding thickness in the Catalogue Editor. The advantage of this is that workshop
drawings of these plates can thus be created.

= Now mount the step onto the stair stringer, using
the “Linear grid” option for bolt insertion, with a
Steel Engineering bolting according to DIN 7990.

= Assign the boltings to the assembly “Step”.

m  Copy the assembly “Step” including both boltings 5
times, using the Clone + Move, 2 points function, taking the specified rise ratio (270/180)
into account.

m  For the first point, click anywhere in
free space.
For the second point: R 270 0 180.

Connect the two stair stringers at
the platform end with a wide flat
steel 220x10, flush via the inner
corner points, and assign it to an
assembly “Platform finish”.

= Proceed as follows to adjust the size of the platform step:

1. Move the angle profile at the back of the step to the back stringer of the platform.
2. Update mitre — via Feature recalculation of the assembly, with external references
switched on (right-click in Feature tab of ICN and select External references...: Use)

3. Adjust the step size via Sketch: Process (use HCM options)

4. Rename the upper assembly “Step” to “Platform”.
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’ To update the assignment of parts to a bolting, open the 3-D Standard tab and select Standard
% Parts & Bolting = Part assignment — New, manually or New, automatically.

= After updating the bolt assignment, change the platform bolting grid to 3 bolts with a
distance of 650, and select the mid-point of the profile as the fitting position (as for the
step).

m  Alternatively, you can use the “Even” grid function. Define the distances as maximum
distances, and the number of bores will be calculated. You can also enter the number of
bores, and the distances will be calculated.

t You can use existing boltings as templates for new boltings to be set. Right-click the
corresponding bolt and select Boltings, Apply standard.

m  Check the part structure once again.

Y Y R RTRCENE S

|&9 TREPPEMITVORDACH_DOKU

M- Bauzeits [Baugruppe] {}
= Treppe {Baugruppe} {}

B Treppenwange links {Bauguppe} {
& B Treppenwange rechts {Baugruppe} {
w4  Podestabschiuss {Baugruppe} {}
By Stife {Baugruppe} 1}

B & Stufe {Bauguppe} {}

@-mg  Stufe {Baugruppe} {}

H B Stufe {Bauguppe} {}

#mg  Podest {Baugruppe} {}
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15.5 Support Posts

In most cases, the easiest way to insert support posts is vertical to the processing plane.

m Delete all processing planes and ‘
switch to Top view, Hidden Line.
m  Crate an assembly “Support post
rear”. L

m Place a pipe with the dimensions 82,5
x 6,3 x 3090 relative to the platform L
edge: R -130 -60. Switch the fitting a(

position to Top axis. |

= On the Steel Engineering tab, select
Plate, new - Rect. 2 Round plate,
Circular form and create the10 mm
support post foot plate with a diameter
of D=200 mm on the base plate,
including the bores.

Draufsicht Stiitze

= Proceed likewise to create the 15 mm
cover plate with a diameter of D=100
and place it on the pipe.

Rohr DIM 2458 82.5x6.3
- Bl15

T BI10

= Adjust the support post length to the
foot plate.

= The front support post can be
obtained by copying the rear support
post with a distance of 2420 mm.

= Rename the assembly to “Support
post front”.

= To connect the support post with the
stair stringer, first create a
processing plane at the rear side of
the platform stringer.

m  Press and hold down the left mouse
button and move the plane onto the
axis end point of the support post.

m 2 flat steels with the dimension 50x8x120 : i —
serve as fixing straps for the staircase. _ R
= Use point option D 50 to project the first |

fitting point from the vertical platform edge -,
to the existing processing plane. |
m  Place the second point directly via the = |

sketch function at a distance of 120mm

= Use the appropriate insertion options and !
rotation angles to get the flat steel into the | D50
correct position at its fitting location. — hier klicken

! [ —
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= You obtain the second flat steel by means of the AQ
Clone + Move, 2 points option. e s
m  The bolting will be inserted according to DIN 7990 at [~y
the centre of the contact surface. @ @
[
4 8 =
}‘ Points located in the centre of a contact surface can be @
% shapped at the diagonally opposite corner points, via the o T
' point option (M2) Mid-point between 2 points. \%,,
'\\Hf

= Assign the new parts to the corresponding assemblies in the part structure.

: Baussits {Baugruppe} {}
% Treppe {Baugiuppe}
: Treppermange links {Bauguppe} {}
= Tiepperwange rechts {Baugruppe] {}
BRFL 10220 {Flachstahi} {0}
BRFL 10x220 {Flachstahl} {0}
FI 80x10 {Flachstahl} {0}

(T 5048 TFlachata) 07
Podestabschiuss {Baugruppe} {4
Stufe {Baugruppet {}

Stute {Baugruppe} {}
Stule {Bauguppe} {}
Stufe {Baugruppe) {1
Podest {Eauguppe}
Stiitze hirter {Baugruppe} {}

Bl 10 {Bleche} {0}

Bl 15 {Bleche} {0}

FI50:48 {Flachstahl} {0}
Schraubverbindung £} {0

Stiitze vorn {Baugruppe} {

Rokr DIN 2458 82.546.3 {Stahlrohie} {0}
BI 10 {Bleche} {0}

BI 15 {Bleche} {0}

84 2-D/3-D Metal Engineering



Exercise: Staircase with Glass Canopy

15.6 Canopy

= To ensure a consistent position of the parts during designing, use the Insert part, via
Explorer (2-D/3-D) function to import to import the assembly “Canopy.kra” first.

= Activate the World Coordinate System. This enables you to place the fixing brackets on the
support posts, via the origins (right-click twice), directly at the correct position in your
drawing.

= Assign the “Fixing bracket support post” assemblies to the corresponding “Support posts”

£y 5.6.52n

EIJEE Bauseits {Baugruppe} 1+

-[@ Bodenplatte {Massivhau} 4}

Lol Wand {Massivhau) b

- Treppe {Baugruppe Montage} {0}
$ Etﬂtze hinken {Baugruppe Werkstatt {03

----- §3 Rohr DIM EM 10210-2 82.5x6.3 {Stahlrabre} {0}
@ Eli0{Blechs} {0}

----- @ ©li5{Bleche} {0}

----- FIS0x3 {Flachstahl} {0}

- Schraubwerbindung 4+ {03

[#]- Konsole {Baugruppe} {F

=- é_ttltze vorn {Baugrupoe Werkstatt} {0+

----- % Rohr DIM EM 10210-2 82 .5x6.3 {5tahlrobre} {0}

----- [@ ©li0{Bleche} {0}

----- @ ©li5{Bleche} {0}

[]--@E Konsole {Baugruppe} {F

EI--JEE Yordach {Baugruppe Monkage! {+

EE@ wandkonsale {Baugruppel {}

----- @ Bl& {Bleche} {0}
----- [ &l & 4Bleche} O
[]--EE Schraubverbindung {Baugruppe} £+
[]---@ Fischer FHE-A dyvn 16 x 125/25 {} {}+
-] Fischer FHE-A dyn 16 x 125/25 4} {4
[]---E] Fischer FHE-8 dyvn 16 % 125/25 {}F 1}
I'_—'I--JEE Wandkonsole {Baugruppel £+
----- B &l & {Bleche} {0}
----- @ &l& {Bleche} {OF
[]--EE Schraubyerbindung {Baugruppe} 1+
[]---@ Fischer FHE-& dvn 16 x 12525 {F {+
[]---@ Fischer FHE-A dyn 16 % 125/25 {} {}
#-[E] Fischer FHE-f dvn 16 x 12525 £ 4
) Frofiblech =
in the assembly structure.
Tebelle
m Create the base plates for the fixing brackets on the wall. |Blech =]
= Use the Elongated plate function for this. The function
combines functionalities for Steel Engineering plates and for T S— B
beams and profiles. : .
= All required dimensions can be taken from the drawing bz H
shown below. 160 k14
| M
k1B
o
| Ji]
B zz
=2 b2z
8 b a0 -
4 usRibringfWerkstof
) [szasmaz |
3 Ereita
= |1f.|:| =]
[ ox ] [ abbeachen |
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m To construct the sword-shaped ceiling support plates shown below, you require a
horizontal plane on the support post axis.

= To shape the form of the plates, use the Plate from sketch (3-D SE) function in the context
menu of the sketch.

il

= First draw the following 2 lines:

T
;7"|F_ ll B _‘—~—\_.1_5LG'|:|_
.'_h “'-':“;I . —
1 Litse I|II

| 2 Lnie i:;
: =

m  Connect the ends of the lines with the Arc — 2 edges function.
m  The result should look as follows:

1

= Now create the inner polyline via an offset with a distance of 45mm. Fillet the ends with a
radius of R10. If desired, add an ornament in the centre within the sketch.

= It might be necessary to apply the Sort GE function, to ensure that the inner polyline will be
closed.

%Q%

m Create a 15 mm Steel Engineering plate from the sketch.
= You can delete the sketch afterwards. If desired, you can process the sketch via the

feature log at any time.
Meu

Copy the plate for the rear post, and e
: assign the wall plates to the fixing ﬂﬂ Ei| QQEJ
brackets. Iransformieren L
SREVRITIE

= Add 2 horizontal support pipes with a total length of 2680mm as shown in the screenshot
below.

m Place the pipes in central position.

= Notch the two plates appropriately.
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Exercise: Staircase with Glass Canopy

Rohr DIN EN 10210-2 82.5x6.3

1300

m  Forthe inclined glass ceiling, first create a sketch in the plane of the two pipe axes.
= Draw the outer glass contour (polygon) via the diagonally opposite J-points of the support
pipes.

= To define the distance of the glass pane, move the sketch in Z-direction 82.5/2+30
upwards. In practice, the distance is, of course, determined by the glass holders used.

= Open the Steel Engineering tab and select Plate, new - Glass 2 Glass, from sketch
to create the glass of VSG 16-2. Place in your drawing by right-clicking twice.

m Delete the sketch and assign the glass pane to the “Canopy” assembly.

= The lateral projection of the glass pane is 100 mm, the projection at the top is 150mm, and
the projection at the bottom is 200mm. The projections are realised by right-clicking the
glass and selecting Sheet processing = Lengthen in sheet direction (via value) in the
context menu.

m If desired, the bores can be directly applied to the glass.

= Use the “Even” grid option for this.

The geometries for the required glass holders are in practice obtained by an appropriate
supplier and are not part of the training.
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15.7 Railing

= You create the railing by placing a profile along a composite edge.

Create an assembly “Railing”, and, within it, create a 3-D sketch.

m  For the creation of the composite edge, switch to the Sketch tab and select New - 3-D
Sketch.

= To draw the guideline for the railing cross bars and the handrail (centrally on the stair
stringer), open the Sketch tab and select Draw - Line - New polyline.

= Adjust the length at the wall (45mm distance), close the corners and fillet the entire polyline
with a radius R80.

’ If you do not want to fillet the composite edge completely, open the Sketch tab and select
% Tools = Sort GE.

m  Place the pipe for the handrail (DIN ISO 1127 — 42.4x2.0 — 1.4301) along the composite
edge.

Profile - Finhauaptionen

(5] | (et () [z) | ] s | () PSS | [ serwerprc =] evtawere [0 [0 :'“
| |
\_ lII_ \Z

Profil entlang Kanten-

Einfilgepunkt Drehwinkel

m After selecting the guideline, the cross-
section will be projected up to the end of the
stair stringer. At this point, the insertion
point and the rotation angle can still be
adjusted. Left-click (see info bar for user
guidance) to generate the profile.

» Load the composite edge via the Feature E-®§ _ Gelénder {Baugruppe Montage} {
log in order to re-use it for the creation of g%‘éliiu%{; 42442 {Stahlrohve} {0}
the railing cross bars. Move the 3-D sketch " [3D-Skizze G

one level up in the part structure.

HH'"‘-\,

= Move the handrail to the correct height.
(1000-42.4/2 upwards).
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Proceed likewise for the creation of a
railing cross bar of round steel 16,
move it 100 mm upwards, and fillet the
ends with a radius of 8 mm.

The end caps of the handrail can be
created from appropriately shaped solid
primitives.

After placing a processing plane onto
the pipe end, you can place the solid
primitives (cylinders) in an appropriately
aligned way.

Merge the cylinders into one part, and
assign a designation and a material.
Alternatively you can also use the
“Revolved solid” part creation.

To spare you a tiresome aligning of
purchased parts, please make sure that you
save the parts with a suitable, practice-
oriented processing plane when saving them
to the catalogue.

= Copy the end cap via the Clipboard to e e S ey
. -\ (Endkappe C #e. U gerade 1 1
the other end of the pipe. : @ Endkappe CNS 42 4x2.0 gerade {} {}
= H:.E Railingstangen (B augruppe) {} [yar—"
% Fd 16 {Rundstahl} {0} O
= Insert the prepared railing post “Railing post.kra” from the Explorer via
coordinate system origins (right-click twice) into a separate drawing file.
]
In many companies, railing posts are re-used again and again, with slightly = 3
modified shapes. It is therefore recommended to create one sample post and save e W
it to the catalogue.
[
= Switch to Hidden Line representation, Side view from left, so that a
corresponding preview image will be created when you save the part. -
Save the post to your catalogue.
In the ICN, right-click the assembly “Railing post” and select Others > ]
Reference part, Save, Detail Drawing - Save as part, with catalogue
entry. Save to Factory standards/Parts and Processings/Table: “Example |
Tab-1".
]
= Now insert the prepared post from your catalogue into your staircase
construction.

2-D/3-D Metal Engineering

-l“?f _,.-"'H.-
=y L
"ﬁL‘f“.
T
e "
b
% l‘l':.:
M, oY 1‘
&, \
- -, W
5

.:lh-

73

g

= f‘% Gelander {Baugmppe} {}
= BE Handlauf {Bauguppe} {}
Q Biokr 150 1127 42 442 {Stahliohre} {0}
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m Pay attention to the active processing plane.

f:”/

960

1130|

\ | 210 | 1100 _ 110 130, /

m  Create the lower railing post initially at the same height as the platform posts.
For the vertical alignment of the post, use the Transform - Move part, 2-D via 2 points

(3-D) function.
To do this, switch to Front view, Glass model representation and create a vertical 2-D

auxiliary line.

®\ ¢? " =
™ | Startpunkt : e
: Zentrum 2D | o /
' —
: Zielpunkt
o Schnittpunkt 2D
=l
e
I5Hiiig
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= The inclination requires an adjustment of the handrail o L -
bracket, and of the rotation angle of the half-shell with the =~ T P :;,/
same function. - L
S -
=
<] ]
L 7
= ]

_|._._..|______

= Assign the two outer fixing straps of the posts in the structure browser via multiple
selection to the stair stringer (and platform stringer, respectively).

m  Copy the railing cross bar using the Clone 2>
Clone + Move part, 2-D via 2 points (3-D)
option. Number of copies: 8 (create assembly).

m  Delete the 2-D auxiliary line.
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15.8 Part Structure

m Finally, check the part structure and fj 5.11.5ZA

BOM-relevance of the parts and E ﬂ bauseits {Baugruppe}
assemblies in your CAD drawing. . [ Bodenplatte {Massivbau} {
m Steel Engineering beams, Steel Eoi B Wand Massvbau}
Engineering plates, Standard Parts P -
and Assemblies are set to BOM- T
relevant by default. -8 Vordach {Baugruppe Montage} {10}
= Use Cut & Paste to insert your parts at = & Rahmen {Baugruppe Werkstatt; {12}
the correct position within the part B Wandkonsole {Baugruppe} {25}
structure. EOE Wandkonsale {Baugruppe} {25}
- [l vSG 12-2 mit Mattfolie {Glasscheiben} {100}
Eﬂ Treppe {Baugruppe Montage} {11}
| @B Treppenwange rechts {Baugruppe} {15}
LR & Treppenwange links {Baugruppe} {16}
A correct part structure is a prerequisite for . H-B¥  Podestabschluss {Baugruppe Werkstatt} {19}
a practice-oriented output of Bills of N
Materials (BOMs) in the Report Manager. __ T :ET;SEE{EELB}QUEL:;EEWM::;?S}E igf}
This enables you, for example, to output e Ry - R ,
mounting lists for fixing elements in . BBy Stufe {Baugruppe Montage) {22):
structure lists. The structures in HICAD will . H-&y Stufe {Baugruppe Montage} {22}
also provide valuable assistance for ¢ HMEE  Stufe {Baugruppe Montage} {22}
assembling preparation. E 'ﬂ Gelander {Baugruppe Montage} {13}

M- Feld {Baugruppe Werkstatt} {14}
_ $ Handlzuf {Baugruppe Montage} {24}
E@ Stitze hinten {Bauaruppe Werkstatt} {17}
i -- Marmiteilz {Baugruppe}
; Schraubverbindung £ o}
Rohr DIN EN 10210-2 82.5x6.3 {Stahlrohre} {101}
Bl 10 {Bleche} {114}
Bl 15 {Blech} {118}
Fl 50%8 {Flachetahl} {122}
Bl & {Bleche} {124)
i Bl 8 {Bleche} {124}
E ﬂ Stiitze vorn {Baugruppe Werkstatt} {18}
- Mormteile {Baugruppe}
&g Rohr DIN EN 10210-282.56.3 {Stahirohre} {101}
- Bl 10 {Bleche} {114}
- Bl 15 {gleche} {118}
- Bl & {Bleche} {124}
- Bl 8 {Bleche} {124}
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15.9 Itemisation

The creation of Bill of Materials (BOMs) and Workshop drawings requires a previous itemisation

of the parts in your CAD drawing. The functions for itemisation can be found in the
Itemisation/Detailing function group of the Drawing tab.

= Itemise your drawing with the Itemisation - ...with options function (in the pull-down

menu of the Auto icon).

m  Specify the settings as shown below and confirm with OK:

5

APogtionsnummer |
Baugruppen 1 10 { Starbwert )
Stzhlbautzile 100 { Startwert)
[ Mormtzile J 2000 { Startwert)

|| Tele; allgzmein | 1000 { Startwert)
Startwert =

| startwert |

|| Hauptteile immer zuerst

[ vergebere nummem sperren
b

@ Ohne

) Infern

() Extern

2-D/3-D Metal Engineering

Zu pagitionierende Tele Filter
@ Alle

- : Chne __':j
(1 Ale sichtbaren
|1 Ale in aktiver Ansicht sichtbaren
Positonizrung gleicher Telle | -

@ Fortlaufend, gesamte Konstruktion
1 Innerhab Baugruppe, gesamts Konstrukton
i Innerhab Baucruppe, akfives Teil + Nebentele

Anzanl Mebenteil-Stufen

B=i Fosifionierung zu beriicksichtigen: |
[/] Teileattribute

Konfiguration
[f] D8-Tailestamm

Foi peometrischer Glechteileicke zu beruecksichtigens ——————————
|] Verschraubung=n

|| Fertigungsart von Bohrungen {Werkstatt, Baustelle, ...}

Mathematiache Toleranz fiir Facettenvergeich

0,001

]Nur neue und geanderte Telle positonieren -

Abbrechen
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The following itemisation functions are available:

Itemisation (Auto icon) Automatically assigns item numbers to all parts, using
the current settings.

Update

...with options Automatically assigns item numbers to all parts. The
settings specified in the Itemisation dialogue window
will be applied.

...individual parts Assigns item numbers to individual parts.

1. Identify the part.

2. Specify the item number.

3. If you want to check whether the item number
already exists, activate the Check conflicts with
existing item numbers checkbox.

4. If you also want to itemise parts that are identical
with the active part, activate the Also itemise
identical parts checkbox.

If the active part already has an item number, it will be
displayed and can be changed. It will also be shown
whether any identical parts exist.

Change parameters Changes the default setting for itemisation

Information

Select parts with same item no. Finds and highlights all parts having the same item
number as the identified part.

Select parts with specified item no. Finds and highlights all parts with a specified item
number.

Delete item numbers

Part Deletes the item numbers of individual parts. The item

numbers of the sub-parts belonging to the active part
will however be retained.

Part+sub-parts Deletes the item numbers of individual parts, including
the item numbers of the sub-parts belonging to the
active part.

All Deletes the item numbers of all Steel Engineering parts.
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15.10 Bill of Materials — Report Manager

Bills of Materials (BOMs) can be created for complete CAD drawings, or only for the currently
active part. Depending on the current settings for BOMs, HiCAD will collect the corresponding
information and display it in the Report Manager.

The functions for BOM creation can be found in the Itemization/Detailing function group of the
Drawing tab.

When you call the function, the Bill of Materials (BOM) dialogue window will be displayed. The
window allows a rapid creation of BOMs and consists of the following options and input fields:

o Attribute source

¢ Report Manager Configuration

* Execute

* BOM type

e Variables file...

Make the desired settings, and start the BOM creation with OK. The Report Manager will then
be launched automatically. Whether you will be shown a structure list or a quantity list depends
on the BOM type you selected in the Bill of Materials (BOM) dialogue window.

m At this point your trainer will explain the different output and setting options of the Report
Manager to you.

m A detailed description of the individual function can be found in the Online Help of the
Report Manager.

= Use the Bill of Materials, for active part function for the creation of an assembly layout.
Activate the desired assembly beforehand.

m For the assembly “Railing” the template file Hicad_Stahlbau0O1.rms has been used, which
led to the result shown below. The template files enable you to create and save list
templates that are tailored to your individual requirements.

-1 G694

I 2|Endhaupe I 1301 oo 0 0.z
128 4|82 400 400 E2I5JRG2 0o 0.0 0.1
12E J2|Rd DIMA03-112 0o 570 | R D s | S235JRG2 0.1 0.1 1.E
EEG tpie | oo 723 5235JRG? | oal 02 0.f
125 & |F1 508 ool 1z00 |—-—— T Y | 5215.IRG2 01 0.4 5
i S|Rd DIN 1013116 | 0.0] 38353 | E— | I | 8235RGT 1 15 i1 485
110 1|Ronr 150 1127 47 &2 0.0 38523 i | fremeees| 14301 51 TAa 7.E
102 L |Rohr DIM 2453 42,432 0.0 11276 | R R s | E235JRH D& 21 9.0
Pos Wange| Begsichron i Bimwn]| L] | Anschaill(Shac) | Anschnill [Flansch) | sabaris) Bangnnung Fira™ | Gemfli]| Gizg paw
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o

15.11 Layouts and Workshop Drawings

m In practice, several types of plans and drawings are required. These are, for example:

> Advance drafts

> Plans for approval (for builders and architects)

» Workshop plans (individual parts and assemblies)
>

Installation plans

= In this training you will first create the present general plan. Use the techniques for view

creation you have learnt in the 3-D Basics training.

m Insert the description in the plan by means of the “2-D text block” function. Please consider
the part assignment of the 2-D parts in the structure browser.

Text blocks can be saved as template files in the Editor and re-used at a later time.

= HiCAD offers several options for workshop drawing
creation.

m  For smaller CAD drawings, the workshop drawings
can be created within one drawing spread over
several sheets.

m Larger CAD drawings need to be divided into several
areas (assemblies), which are then saved to external
drawing files. The external assemblies need to be
referenced externally, if changes to the original CAD
drawing can be expected, which would require a
synchronization of the parts.

m The function Reference, Save, Detail drawing can
either be accessed via the Reference function group
of the Drawing tab, or via the context menu of the
part or assembly.

™ 3D-Teil referenz., speichern | 22

[ Teil referznzieren}

[ Referanzieren estern

[ Referenzieren intein

[ Gleichtzie ebenfals referenzieren

[T eil ook EinzetteilZeichnung] -
(7 Ale Teil epeichern

(0 Al T el mit K atalogertrag speichen
i@ EinzeteilkLeichnung erstellzn+speichern
[ EinzelteibZeichnuna. mit Oplicoen

(Lweier | [ bbrechen)

m  Specify, via the options in the dialogue, whether you want to reference the assembly or the

part.

m The detail drawing generation can be performed either directly or with options.

[} If you Select . .W|th E"dldmr_‘-lt‘l fur Emzeltelzexchnung
options, you can Opsicnen ZazickringzSkaienng
. . . ¥ Zeichrungsrahmen =irfiigen * Hauptmalstah voigeber, Zzchnungsrahmen suswible
specify various settings o 3
bpf fy . h 9 I Parmessimale snbleden (el 110 =
e ore Cre?tmg the I Fis Stahibanieile) Wt zeichning erstiln  Zeizhrumgurmen vrgeben, Mallah srpmissn
detail drawmg. I Fix Blachialle) Blachaaricklung sisalen e clt Febrrme Figu |
F Erzelisizaichiung nach Erslelung gedifnet lassen AL ,71”
Kardnneen (T~ | o Ea—
Anzohl d=i Arachiber: 4 =
finsichla sinshe bingen
Aresichisoicie klior Apsichlename Araichiz §ichibark e ::Efnamm
auichien
Al | G chi =] Fedsienscht [HidderiLing gaatichal =] ¥
deach2 | [Satenann virice 7] [eeteranmchiuinks [Higgenlie geancher x|
srschl 3| [Draoid =] [t [Hiddeiline geatichet =] M
Arachid | o cromenis 2 =] Jwaremerie 2 [schattetmitbereer =]
Araichl |L1:|-|-r‘-|- Intes j II'I'.' ot e Lnban I lidoes-Line gestichel j ¥
Araichi B |5.'|=i'|'l‘-.'l' e j I"I'\LF'I i hilen I fidoerLing gasicher j c
Diefauk-Parame= ax Abbr=ch=n

= Give the drawing a name and save it.
= Within the drawing you can now create further views.
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Workshop drawings

Please note the following:

Change referenced assemblies always in the original, complete CAD drawing, and save

|
the changed, referenced assemblies with the referencing functions.

= When applying changes to your drawings, please remember to re-itemize your orginal,
complete CAD drawing before saving the assemblies.

|

The changes in the original, complete CAD drawing will then also be transferred to the
drawing files containing the workshop drawings.

Descriptive, well-structured workshop drawings and detail drawings are required for a reliable
planning and production. The automated creation and management of these important
documents in HiICAD is particularly suitable for large Steel Engineering assemblies:

All detail drawing views are managed in one view group, including the view-comprehensive
parameters.

All views of a view group will be linked to each other.

Each view group can contain several, auto-generated views per part or assembly.

HiCAD automatically arranges the views, view groups, item numbers and annotations,
dimensionings etc. in a collision-free and space-saving manner.

Production drawings can be automatically spread over several sheets with separate
drawing frames if desired.

Assembly BOMs can be automatically integrated in the workshop drawing if desired.

Hews Werkshattzeichnungen erzzupgen i

To create a new workshop drawing, activate the izt nune=e

Drawing tab and select Itemization/Detailing
- Drawing derivation. The Derived drawing
dialogue window will be displayed.

2-D/3-D Metal Engineering
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gy
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r

Proceed as follows:

1. Select the target for the workshop drawing from the Drawing target list box.

2. In the Part selection area, select the part types that you want to be transferred to the
workshop drawing by activating/deactivating the corresponding checkboxes.

3. In the View groups to be created for... area, activate/deactivate the checkboxes for
the parts for which you want to create view groups.

4. Specify the Settings for drawing sheets, view groups and views.

5. In the Views to be created for ... area, determine which views for assemblies,

beams, plates etc. you want to be combined in a view group.

Once you have specified all required settings, close the window with OK.

If you have chosen the setting Part selection: Select, individually, HICAD will now prompt you
to identify the parts to be included in the workshop drawing. To end the part selection, press the
middle mouse button.

The workshop drawing will be directly created as a Sheet view - either in the original drawing or
in a new drawing. It can be opened in the Views tab of the ICN.

Please note:

To create a workshop drawing in the current Steel Engineering drawing, first itemize the
parts of the Steel Engineering drawing with the same-named function.

The inserted Sheet views can be deleted via the context menu for views (either in the ICN
or in the drawing area).

View groups will always be displayed within a rectangular frame that encloses all views of
the group. This frame can be adjusted to the size of the view group with the Update
derived drawing function.

Bolts and sub-parts will be dimensioned automatically. Plates will be rotated 90 degrees if
their extension in Y-direction is greater than in X-direction.

3-D weld seams can be automatically annotated in the workshop drawings. This behaviour
can be activated or deactivated in the Settings for views dialogue window.

For countersinks (e.g. DIN74), the standard, nominal diameter and (if any) auxiliary notes
will be displayed in the generated workshop drawing.

When you call the function again, the last specified settings will apply. Use the Derive »>
Change settings options to change the settings of an already existing workshop drawing
subsequently.

To influence the arrangement of the views, open the Views tab of the Ribbon and select
View Functions - Show > ...

When creating the workshop drawing views, the current projection will be recognised as
the so-called “Required position”. This enables you to restore the original position at any
time after rotating the view.

More information on these functions can be found in the Online Help.
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Exercise: Staircase with Glass Canopy

15111 Exercise: General Plan

L3

The template can be found in the appendix of the training book.

Create the corresponding views on a 1:20 scale on Sheet 1. Dimension the views, add
item numbers and annotations.
m Insert a DIN A2 drawing frame.

15.11.2 Exercise: Workshop Drawing for Stair Stringer

Create a workshop drawing of the assembly “Stair stringer right”.
The layout should include drawing frame, BOM, detail views of individual parts of the
assembly, and auxiliary, production-relevant dimensions.

m Use the automatic workshop drawing generation in conjunction with individual views.
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L3
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15.12 Additional Exercise “Staircase”

15121 Platform Extension

= Add a T-beam to the platform construction, via the mid- points at the inner side of the L-
profiles. In such cases, the Notch function offers you the option to re-define the notching

via new parameters.

= Apply 8 mm chamfers to the T-beam ends for a production-oriented shape.

Stahlbaueinstellungen
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= Move the T-beam 220 mm to the rear, and copy+move it 440 mm in opposite edge

direction.

15.12.2 Bolt Finished Platform Together

= Finally, connect the two stair stringers with the rear platform stringer. The parts should

again be assigned to the corresponding assembly.

= If required, bolt the L-profile at its mid-point to the rear platform stringer.
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16 Import / Export Interfaces

> Besides a bidirectional LogiKal interface (see Chapter 7 Creating Glazing
Constructions with LogiKal), HICAD offers a number of other Import and Export
Interfaces:

16.1 NCX Export for Machine Control (Profile Machining Centre
PZB)

» The NCX Export Interface saves beam and profile lengths, cutting angles and
processings to a NCW file.

16.2 3D-PDF Export

» The 3D-PDF file can be read with any free PDF Reader. The advantage of PDF files is
that they do not disclose the know-how contained in the drawing, but still provide the
builder or architect with sufficient information for the realisation of the project.

16.3 IFC Import/Export

» The Industry Foundation Classes (IFC) constitute an open civil engineering standard for
the digital calculation of building models.

» |IFC is supported by many software programs for the purpose of building data
exchange. Fields of application include 2-D/3-D CAD, or statics and energy
calculations. Data exchange takes place by means of IFC files with the extension *.ifc.

16.4 2-D and 3-D DXF/DWG Import/Export

16.5 Step/lges Import/Export
» 3-D Solids Interface

16.6 Statics Interface

» DSTVandIFC
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17 Glossary

3-D C-Edge Constraint Manager
The C-Edge Constraint Manager is based on the 3-D HCM and is a tool enabling you to
position and move composite edge elements. For this purpose, the c-edge elements are
linked to each other through so-called “constraints”, i.e. dimensional and logical relations and
restrictions. The C-Edge Constraint Manager then transforms the appropriate elements in
such a way that the defined constraints are fulfilled.

3-D Part
A 3-D part consists of 3-D graphical elements (short: “GE”), which constitute the lowest
organisational units of a 3-D drawing. These can, for instance, be 3-D points, 3-D (poly)lines,
3-D circles/arcs or surfaces.

3-D Polyline
a 3-D polyline is a structurally coherent (i.e. continuous and uninterrupted) succession of
individual 3-D lines. The end point of the previous line coincides with the start point of the
next line.

Absolute coordinates
Coordinates referring to the point of origin of the current coordinate system (short: “CS).

Similarity transformation
Simultaneous moving, rotating and scaling of a part.

Active attributes
HiCAD offers the option to define particular attributes as active attributes. For all subsequent
manipulations only elements with these attributes will be taken into account.

Additional modules
Modules that serve as supplements to other modules. You can, for instance, supplement the
Steel Engineering module with the Metal Engineering module.

View
Projections, i.e. two-dimensional representations of 3-D objects. One distinguished between
standard views (top view, side view, front view), isometric and axonometric views. View
generation is based on projection principles. See also Projection methods.

Arithmetic expressions
Valid algebraic combinations of constants, numeric variables, arithmetic operators and
brackets.

Assembly
Several combined (“assembled”) parts under one superordinate part. This superordinate part
serves only the purpose of structuring (enabling, for instance, a simultaneous moving of the
sub-parts below it, or the assigning of part master data to the superordinate part) and can
therefore be an empty dummy part, i.e. it needs not necessarily contain lines, dimensionings
or similar.

Associativity
“2-D/3-D Associativity” basically describes the possibility of a combined and simultaneous
working in 2-D and 3-D. A HiCAD drawing files can both contain 2-D and 3-D objects. 3-D
views can be added to technical drawings in 2-D, 2-D objects can be used as a basis for 3-D
drawings etc.

Attributes
Characteristics such as colour, line type and line thickness, influencing the appearance and
shape of elements.
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Autopilot
A tool for the identification of points and parts. If the Autopilot is switched on, the cursor
provides information on snappable points, (e.g. start points, end points or mid points of
edges, perpendicular base points, intersection points or centre points of circles) when it is
moved over the drawing objects. These points can be taken over directly, i.e. without
activating a point option.

Basic elements
The lowest organisational units of a HICAD drawing. In 2-D, these are graphic elements
(GE); in 3-D, these are edges, surfaces and 3-D points.

Beam processing functions
Functions enabling you to cut, notch, move, rotate, mitre-cut or divide beams and profiles.

Bill of Materials (BOM)
List of all parts of which a product or an assembly is made up, indicating quantities and
designations of the parts.

C-Edge Constraint Manager
see 3-D C-Edge Constraint Manager.

Clone
Parts which are required several times in a drawing can be copied. These copies are called
“clones” in HICAD. You can choose whether you want to combine all parts into one part or if
you want to create one superordinate part above the copied parts instead.

Closed contour
Continuous contour with coinciding start and end point.

Collision check
Function in the Information tab that checks whether there are collisions of parts in the
drawing. If so, the detected collision is shown in the drawing and in the graphics window of
the ICN.

Colour table
Enables you to pre-set the assigning of available colours.

Construction Aids
Pre-defined parts or processings facilitating the construction. In the Steel Engineering
module, these are, e.g. boltings, base plates, bracings, connections, corner plates, rigde
joints, stairs, steel halls etc.

Contour
Contours link graphic elements that are optically but not structurally coherent — they need not
belong to the same part.

Contour edges
“Apparent” edges of the analytical 3-D model.

Contour hatching
Hatches a surface defined by a contour. Lines integrated in the boundary line may belong to
different parts.

Copy
see Clone

Crosshairs
Cursor symbol which is moved by the mouse, indicating the current position on the screen.

Cursor
See Crosshairs

Cut
Cutting of beams in longitudinal direction, along the entire beam length.
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DAST connection
Steel engineering connections according to DSTV/DASH.

Data structure
The HiCAD drawing structure. The highest organisational unit in HICAD is the Drawing. The
Drawing contains Main parts which may in turn consist of Sub-parts. The individual parts
consist of the lowest organisational units: In 2-D, these are the graphic elements (GE) and in
3-D, these are edges, surfaces and 3-D points. See also 2-D part, 3-D part, Drawing.

Default value
The value of a parameter which is set when the program is started.

Detail
An arbitrary drawing detail can be defined and inserted separately on the screen in any scale.

Display lists
Graphic card drivers for an accelerated output of graphic elements on the screen.

Drawing
Drawing file in HICAD with the file extension .SZA. A Drawing is the highest organisational
unit in HICAD. It is composed of 2-D and/or 3-D parts. These can be assemblies, parts or
bores. Each drawing is assigned an unambiguous name, enabling the user to retrieve it.

Drawing detail
The detail of a drawing that is displayed on the screen (alterable by the “Rectangular zoom
window” and “View all” functions.

Drawing layout
Arrangement of several HICAD drawings on one drawing sheet for print output.

Engineering axonometry
Parallel projection with an unshortened representation of the y-axis and z-axis and a
shortened representation of the x-axis. The x-axis stands at under angle of approx. 41°, the
y-axis under an angle of 7° to the horizontal of the screen plane. The z-axis stands
perpendicular on it.

Error tolerance
Rounding errors in numerical values. Point coordinates, e.g., can be checked for a specific
tolerance. Errors are calculated as the difference between the exact and the rounded value.
The error tolerance, i.e. the allowed maximum deviation, can be preset within a specific
range of values. Two points are recognised as one if the distance between them is less than
the given value.

ESM (European Solid Modeller)
ISD’s self-developed 3-D kernel.

Feature
When designing in 3-D, Feature Technology is active by default. Feature Technology records
all processing steps (“Features”) in a Feature log. Activate the Feature tab in the ICN to view
the processing steps applied to the active part. With the help of Feature Technology you are
enabled to conveniently change parts via the Feature log, and even correct processing steps
that were applied long ago, without having to repeat these steps once again. You can also
derive Feature variants from the Feature log. If Feature Technology is switched on, HICAD
automatically generates the parametric dimensions of the part. These are visible if the part
and the Feature step are active. Such parametric dimensions provide, besides the Feature
log, an additional option to change parts. See also Parametric dimensions.

File group
Short term for a HICAD directory path, defined in the FILEGRUP.DAT file.

File name
The name under which the operating system (e.g. Windows or UNIX) manages the HICAD
data, such as CAD-drawings, parts, macros etc.
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Fitting points
Points used for reference, e.g. when transforming parts.

Fitting types
In the Steel Engineering module you can fit parts in the drawing with the fitting types ,Fit
beam in space” or ,Fit beam perpendicular to processing plane®. If both fitting types are
DEactivated, you can fit the beam parallel to the processing plane; if the fitting type ,Fit beam
perpendicular to processing plane” is active, the beam will be perpendicular to the active
processing plane. If the fitting type ,Fit beam in space” is active, you can fit beams in any
direction, independent of the active processing plane. To specify the end point of the fitting,
you can use the point option ,Relative” or directly select the end point on an existing beam.

Freehand symbol technique
Special input method based on the definition of a symbol and assigning it to a specific
command.

Generating rules
Set of rules enabling an automatic generation of numbers or names for many fields of the
database mask, via the program genummer.exe. Normally, you let your computer generate
the file name.

Graphic elements (GE)
Lowest organisational 2-D unit. Graphic elements can be points, symbols, lines, circles/arcs
or conic sections.

HCM HiCAD Constraint Manager
Parametric designing on the basis of Constraints, linking individual objects to each other by
means of geometrical relations.

Identical part search
Automatic detection of parts with an identical geometry in the drawing. HiCAD performs the
identical part search during the itemisation of a drawing. All detected identical parts in the
drawing are assigned the same item number, only one detail drawing is created for identical
parts, and are displayed as only one part in the workshop drawing. Also see Item numbers.

Identification
Selection of an object with the cursor.

Intelligent Cursor
Context-sensitive cursor providing you with functions appropriate to current processing
requirements. If you process objects, for instance, you are prompted to select the object you
want to process. When you now move the cursor on an object, this object is highlighted and
can be selected for processing by a mouse-click. Only those functions which are useful for
the processing of this object are then displayed.

Interfaces
Software modules enabling data interchange with other programs.

Isolated points
Independent points that can be inserted freely into the drawing. They need not be located on
a drawing object. Isolated points can be used as auxiliary point during drawing creation, or as
fitting points during transformations.

Item numbers
Item numbers can be assigned automatically or manually before creating a Bill of Materials
(BOM), Detail drawing or Workshop drawing. ltem number tags are not absolutely
necessary, they do however facilitate the assigning of item numbers to the corresponding
part in the drawing. Itemised parts will appear in the BOM and enable the detection of
identical parts in the drawing. Identical part search ensures that all identical parts detected in
the drawing are assigned the same item number. only one detail drawing is created for
identical parts, and are displayed as only one part in the workshop drawing.

Kinematics
Functions for modelling, simulating and analysing complex freely definable linkages.
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Kinetostatics
Analysis function for bearing and element stress.

Layer
The working with layers can be compared to the working with transparent foils on a
conventional drawing board.

Level
see Overlap and Overlap level.

Library
A “pool” of parts (part library), macros or variants (macro library). A library can be added to
the screen menu. In this case, the calling of the parts, macros or variants takes place via
selection of the appropriate library entry.

Local 3-D coordinate system
Temporary 3-D coordinate system, which can also be rotated.

Logical relational expression
Simple arithmetic comparison, e.g. a > b (a is greater than b). The value of the expression is
TRUE or FALSE.

Logical variable
Variables which always return either TRUE or FALSE as a result. They are frequently used in
macro technology, especially in loop and IF conditions.

Macro
Sub-program accessing HiCAD functions and creating variants in cooperation with the user.
Macros serve the purpose of reproduction, i.e. the repetition of permanently returning HICAD
processes.

Main part
The second-highest organisational unit after the Drawing. A Main part can be an Assembly or
an individual part. An unlimited number of Sub-parts can be assigned to a Main part to
provide the logical structure of a real construction. See also Part structure and Sub-part.

Mark-up
Use this function to add comments and correction suggestions to a document, without having
to change the original document. All comments added via mark-up are identified by user
name and date and can thus be retraced at any time. When you use this function, a file with
the extension *.RED is created. You can pass this file to other users and view it with an
external Viewer.

Mask
A form that is temporarily displayed for the input or selection of data. Masks usually contain
input fields or selection fields for parameter specification, as well as explanatory texts.

Model area
A view in which all other views, sectional views, detail views, drawing frames etc. are hidden.
This enables a fast and structured working. Besides, you can rotate the model view without
any repercussions on the production views in the sheet area. See also Sheet area.

Mouse
A device that is manually moved over the table, thus moving and controlling the crosshairs on
the screen.

Move+Rotate objects
Simultaneous moving and rotating of objects.

Multiple selection
Selection of several parts in the ICN or in the drawing while holding down the CTRL or SHIFT
key.
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Named points
Points to which a name has been assigned. This is possible for start points and end points of
lines and arcs, as well as for isolated points.

Natural coordinates
All 2-D data contained in the drawing refer to the Cartesian coordinate system. These
coordinates are also referred to as natural coordinates.

Object selection
A choosing of objects for processing, either via identification, name entry, or with the
structure browser.

Overlap level
You can also create overlaps in 2-D by assigning so-called “overlap levels” to parts. See also
Overlap contour and Overlaps.

Parametric dimension
Dimensionings appearing on the active part if the Feature is switched on. If you right-click a
dimensioning, you are enabled to change the part. See also Feature.

Parametric Variant Technology
Parameterised geometric form, formulated as a procedure; e.g. the representation of a nut
M10 according to DIN 934, 936.

Part
A drawing consists of very many graphical objects, such as lines, texts, dimensionings, etc.
All of these graphical objects are assigned to parts. One part can, for instance, be called IPE
300 or Bl 100x200x1, another part can be called ,Flange®. All lines, dimensionings, texts and
processing symbols of the IPE-beam are assigned to the part IPE 300, all lines, dimensions
etc. of the flange are assigned to the part ,Flange®. If you move, rotate, mirror or delete such
a part, all dimensionings, texts and processing symbols are also moved, rotated, mirrored or
deleted. If you create a part as main part or sub-part depends on whether the part is an
individual, independent part, or if it belongs to another part. For instance, an individual
haunched plate in a detail drawing would, as an independent part, be created as a main part.
If this haunched plate is welded to a steel beam in an assembly drawing, it would be a sub-
part of an assembly part (consisting of beam and plate). See also Main part, Sub-part.

Part hatching
Hatching of a surface bordered by a closed polyline. All lines of the border need to belong to
one part.

Part list
Multiple selection of parts. The aim is to process several parts in one step.

Part structure
Subdivision of the drawing into main parts and sub-parts. The part structure describes the
logical composition of the real construction. It constitutes, for instance, the basis for the
automatic Bill of Materials (BOM), the automatic creation of subtractions for part hatchings,
and part overlaps (in the 2-D module).

Patterning
Special hatching of a surface, with arbitrary symbols instead of lines for the hatching.

Pixel graphic
Pictures constructed of a regular array of dots (pixels). Pixel graphics are created when you
scan pictures. Common formats are BMP, JGP, GIF, PCX and TIF.

Point options
Functions for the specification of point coordinates. The functions are subordinated to all
other functions, i.e. they can be activated within other functions.

Point specification
See Point options.
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Polyline
A polyline is a structurally coherent (i.e. continuous and uninterrupted) succession of
individual lines, circular, elliptical, hyperbolic or parabolic curves. The end point of the
previous line coincides with the start point of the next line.

Projects
A means to effectively arrange, file and archive drawings and parts. Projects can be real
working projects, they can however also be used to file, e.g., all drawings created in one
year, by one specific department, by one specific customer etc. Projects can in turn contain
individual sub-projects.

Project-independent
A project created by the computer. All drawings are automatically assigned to the project
“Project-independent”, even if you assign a drawing to a specific project. This project named
“Project-independent” cannot be deleted. Therefore you can delete all projects that you
created yourself, without losing any drawings: Even after deletion, they still exist in the project
named “Project-independent”.

Redo
Reverses the previous UNDO.

Reference point
The point to which a later subsequent transformation or point specification refers. See also
Fitting point.

Relative coordinates
The coordinates refer to a point in the drawing that is not necessarily the origin of the
coordinate system. For many functions, this reference point is automatically defined by the
last set point. Reference points can however also be defined by the user.

Report Manager
Program for the creation of individual Bills of Materials (BOMs) based on the HICAD
part/assembly structure or the HELiOS product structure. The BOM provides information on
the individual components of a product, as well as on their quantity, names, item numbers
etc. You can also set filters, define different sort criteria or export to Excel or HTML format.

Representation
HiCAD offers several options for the representation of the 3-D parts in a drawing, e.g.
shaded, as glass model, with or without hidden edges).

Screen coordinate system (Screen CS)
Coordinate system the XY-plane of which is the screen.

Screen menu
The area(s) of the graphic screen containing the icons, symbols and texts for function calls.

Screen plane
The XY-plane of the screen coordinate system.

Screenshot
Saving of the current screen or screen details as pixel graphic.

Sheet area
The area in which you can create and name production views. These can be normal views,
sectional views, detail views, drawing frames etc. You can also create several sheet areas,
e.g. one for the quotation drawing, one for the production drawing etc. See also Model area.

Sketches
3-D part with free edges that lies in a plane. Sketches can be used, e.g., for the derivation of
extruded solids, revolved solids, bores, subtractions or C-edge sweeps. The name “3-D
SKETCH?” can be changed if desired. After creating a sketch the appropriate sketch functions
are displayed. The sketch is drawn in the active processing plane or, if no processing plane is
available, in the XY-plane of the active coordinate system. Before drawing a closed contour
in the sketch, you can use the “New plane, ...“ functions to define or activate a different
processing plane.
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Snap circle
If snap mode is active, points within the radius of the displayed circle are automatically
detected.

Snap mode
If this mode is active, points can be specified directly, without calling a point option. See also
Autopilot.

Snap radius
Determines the size of the snap circle.

Solid primitives
Basic 3-D bodies such as cuboids, cylinders, spheres etc.

Status bar
Displays information about the current program status, i.e. the name of the active part, active
view and active coordinate system, etc.

String
A sequence of alphanumeric and special characters.

Structure browser
Graphic representation of the part structure, allowing you to process the structure.

Sub-part
A part that is subordinated to another part (Main part or Sub-part). See also Part structure
and Main part.

System variable
HiCAD variables with fixed values.

Unit of measurement
Preset unit of measurement (mm, cm, etc.) for all value entries.

Undo
Reverses the previous action.

Transformation
Umbrella term for positional and size changes of drawing parts, such as displacements,
rotations, mirrorings, enlargements, downsizings etc.

Trim
Limits or shortens lines with respect to given conditions.

User-specific variable
Variables which have been defined by the user and to which, depending on the type, a
numerical value or a character string has been assigned.

Value entry
Input of numbers, arithmetic expressions and variables.

Variables memory
Function enabling a rapid definition and saving of variables.

Variant
You use Variant Technology to create “Variants”. The creation of 2-D or 3-D variants makes
sense if you frequently draw similar parts, differing only in their dimensions, the number of
bores, etc. After calling a variant you only need to specify the required parameters (width,
height, number of bores etc.), and HiCAD then draws the part automatically. Parts created
with Variants (or Macros) can be simple sheets or plates, but also complex assembilies.

Vector graphic
An image the data structure of which consists of vectors. In this type of graphic you can
delete, move, change or scale the individual graphic elements. Vector graphics usually
require less memory than pixel graphics.
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View All
Displays the entire drawing on the screen.

Window
The division of the screen into several processing windows, enabling you to process various

details of a drawing.

Workflow
Defined working process enabling you to define the steps that documents, folders, projects or
parts need to run through in a company, and to control their handling. Such a process can,
for instance, be the way from the concept to the realisation of a product. The number of the
test steps that an object has to pass through can be defined via the Workflow chart. Please
note that a Workflow chart can only be defined for objects of the object type 2-D/3-D drawing,
part, folder, project, general document, DXF, IGES or NC program. Workflows can be pre-
defined or user-defined. The access rights are linked to the object names and determine
whether an object can be viewed, created, changed or deleted. You can use the "User*
function to define the rights of the individual users.

Zoom
Functions enabling you to enlarge or downsize the objects on the screen.

ZTL file
A 2-D drawing file with the extension ZTL, used in older HiCAD versions.
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